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Welcome
The Tektronix TekExpress DisplayPort software supports CTS 1.2 and CTS 1.4. The software uses Tektronix DisplayPort AUX controller
(DP-AUX for standard DP 1.2 DUT) and Unigraf DPR-100 to automate DisplayPort physical layer source compliance tests for Standard
and Type-C connectors. The DP-AUX/ DPR-100 puts the DUT in different test modes and eliminates the need for user intervention during
testing. For Alpine Ridge DUTs, the software automates the TenLira scripts to put the DUT into different test modes.

Tektronix provides various tools such as DPOJET (Jitter and Eye Analysis tool), SDLA (Serial Data Link Layer Analysis), and DisplayPort
essential (DisplayPort measurement library) to perform the characterization/debug of the silicon, and TekExpress DisplayPort application to
perform the compliance tests.

Welcome
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Getting help and support

Related documentation
The following manuals are available as part of the TekExpress DisplayPort Tx Automated Solution documentation set.

Table 1: Product documentation

Item Purpose Location

Online Help In-depth operation and UI help

PDF of the Online Help In-depth operation and UI help

PDF file that ships with the software
distribution (TekExpress Displayport-Automated-Test-
Solution-Software-Printable-Help-EN-US.pdf).

It is also available in HTTP://WWW.TEK.COM

See Also
Technical support

Conventions used in help
Online Help uses the following conventions:

• The term “DUT” is an abbreviation for Device Under Test.
• The term “select” is a generic term that applies to the two mechanical methods of choosing an option: using a mouse or using the

touch screen.

Technical support
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix for more information.

When you contact Tektronix technical support, please include the following information (be as specific as possible):

General information
• All instrument model numbers
• Hardware options, if any
• Probes used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Getting help and support
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Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save the setup files for all the instruments used and the application
• If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file
• If possible, save the waveform on which you are performing the measurement as a .wfm file

Getting help and support
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Getting started

Installing the software

Compatibility
The TekExpress DisplayPort Tx application runs on the following Tektronix oscilloscopes:

• DPO/DSA/MSO71254C, DPO/DSA/MSO71604C and DPO/DSA/MSO72004C Series Digital Oscilloscopes
• DPO/DSA72504D and DPO/DSA73304D Series Digital Oscilloscopes
• DPO/MSO 71254DX/71604DX/72004DX/72304DX/72504DX/73304DX Series Digital Oscilloscopes
• DPO71304SX, DPO71604SX, DPO72004SX, DPO72304SX, DPO72504SX, DPO73304SX, DPO75002SX, DPS75004SX,

DPO75902SX, DPS75904SX, DPO77002SX, and DPS77004SX.

See Also
Minimum system requirements

Minimum system requirements
The following table shows the minimum system requirements for an oscilloscope to run TekExpress.

Table 2: System requirements

Component Requirement

Oscilloscope

MSO70000C/DX, DPO70000C/D/DX/SX, and DSA70000C/D series oscilloscopes with at least 8 GHz
for Compliance Mode for RBR and HBR, 12.5 GHz for Compliance Mode for HBR2 and 16 GHz for
Compliance Mode for HBR3.

For list of compatible oscilloscopes, see Compatibility.

Processor Same as the oscilloscope

Operating System Same as the oscilloscope (Windows 10 64-bit)

Memory Same as the oscilloscope

Hard Disk Same as the oscilloscope

Display Same as the oscilloscope

Software • DPOJET, Jitter and Eye Diagram Analysis Tool, v10.3.0. or later

• Microsoft Internet Explorer 6.0 SP1 or later

• Microsoft Photo Editor 3.0 or equivalent software for viewing image files

• Adobe Reader 7.0 or equivalent software for viewing portable document format (PDF) files

• SDLA software for creating CTLE filters

Table continued…

Getting started
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Component Requirement

Probes TCA-SMA single-ended, P7313SMA, P7520A , P7516, P7513A, P7625 (Probe Tips: P76CA292,
P76CA292C, P76CASMP, and P76TA), P7633 (Probe Tips: P76CA292, P76CA292C, P76CASMP,
and P76TA), P7720, P7720-SMA, P7716, P7713, P7713-SMA, P6245, P6246, P6247, P6248, P6250,
P6251, and TCP202.

Test fixtures • Wilder DisplayPort fixtures (DP-TPA-P, DP-TPA-R, DP-TPA-C, DPI-TPA-PA, DPI-TPA-PRRCA,
MDPI-TPA-PA, and MDPI-TPA-PRRCA).

• Vprime DisplayPort Inrush current test fixture.
• DisplayPort Interposer Standard Plug to Standard Receptacle.

Type-C DPC-TPA-R. DPC-TPA-C, DPC-TPA-CB, DPC-TPA-PCB, DPC-TPA-RR,DPC-TPA-PR, DPC-TPA-
RRCB, DPC-TPA-PRCB, and DPC-TPA-PRRCB

Other Devices • Microsoft compatible mouse or compatible pointing device
• Four USB ports (two USB ports minimum)
• Unigraf DPR-100 or Tektronix DP-AUX
• GRL Alt Mode controller (GRL-USB-PD-C1) - Optional device
• Wilder DPC fixture
• Type-C to Standard DP Dongle

See Also
Compatibility

Supported probes
The table gives the list of probes recommended for the DisplayPort Tx application.

Recommended Probe model
P7313SMA, P7520A , P7516, P7513A, P7720, P7625 (Probe Tips: P76CA292, P76CA292C, P76CASMP, and P76TA), P7633 (Probe
Tips: P76CA292, P76CA292C, P76CASMP, and P76TA), P7720-SMA, P7716, P7713, P7713-SMA, and P7720 differential probe based
input, which offers the most efficient test configuration, by offering inputs for all 4 differential DisplayPort signals concurrently. This
configuration precludes the testing of common mode and skew measurements.
TCA-based single-ended input (direct Tektronix oscilloscope inputs) supports both differential and single-ended tests including intra-pair
skew measurements on up to 2 concurrent DisplayPort signals. 4 lane TCA based single-ended input is supported using RF Switch.
For testing Aux measurement are P6245,P6246, P6247, P6248, P6250, and P6251.

Getting started
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Install the software
Install the software on a compatible Tektronix Real-Time oscilloscope running Windows 10. For a list of compatible oscilloscopes, see
Compatibility.

1. Go to the www.tek.com Web site and search for DisplayPortTx to locate the installation file. Download the DisplayPort Tx web installer
from www.tek.com.

2. Close all applications, including any TekVISA applications.
3. Double-click the executable file to extract the installation files.

After extraction, the installer launches and the software automatically installs in the following location:

Windows 10 location: C:\Program Files\Tektronix\TekExpress\TekExpress DisplayPortTx
4. For Alpine Ridge DUTs, they run the same executable file on DUT to install the required software for controlling the DUT and follow the

installation instructions.

See Also
Minimum system requirements

Activate the license
Activate the license using the option installation wizard on the oscilloscope. Follow these steps to activate the TekExpress DisplayPort Tx
license: 

1. From the oscilloscope menu bar, click Utilities > Option Installation.

The TekScope Option Installation wizard opens.

2. Instructions for using the Options Installation window to activate licenses for installed applications is provided in the oscilloscope online
help. Press the F1 key on the oscilloscope keyboard to open the Option Installation help topic. Follow the directions in the topic to
activate the license.

Getting started
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See Also
View version and license information

View version and license information
Use the following instructions to view application version information and version information for the application modules such as the
Programmatic Interface and the Programmatic Interface Client.

To view version information for application, click the Options button in TekExpress application and select About TekExpress. View
Version Details in the About Tektronix TekExpress DisplayPort pop-up. 

Note: This example shows a typical Version Details dialog box, and may not reflect the actual values as shown when you open
this item in the application.

Click View End-User License Agreement link in About Tektronix TekExpress DisplayPort pop-up, to view the end-user license agreement.

See Also
Activate the license

Options menu

Getting started
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Introduction to the application

DisplayPort Tx application overview
TekExpress is the Tektronix Test Automation Framework, developed to support your current and future test automation needs. TekExpress
uses a highly modular architecture that lets you deploy automated test solutions for various standards in a relatively short time.

The Tektronix TekExpress DisplayPort software supports CTS 1.2 and CTS 1.4. The software uses Tektronix DisplayPort AUX controller
(DP-AUX for standard DP 1.2 DUTs) and Unigraf DPR-100 to automate DisplayPort physical layer source compliance tests for Standard
and Type-C connectors. The DP-AUX/ DPR-100 puts the DUT in different test modes and eliminates the need for user intervention during
testing.

Key Features: DisplayPort Tx has the following key features

• Fully-automated compliance testing of DP1.4 source devices (Standard and Type-C connectors).
• Support for Dual Mode (DP++) and AUX channel tests.
• Support for running automated tests through TenLira scripts for Alpine Ridge DUTs.
• Integration with Tektronix DP-AUX (for standard DP 1.2 DUTs) or Unigraf DPR-100.
• Automatic insertion of modelled channel losses, CTLE equalization and DFE as per the CTS.
• User-Defined mode for characterization, margin testing and debugging (in addition to compliance testing).
• Support for P7625 and P7633 TriMode probes.
• DP-AUX or Unigraf DPR-100 provides DUT control for full automation, saving hours of manual DUT settings.
• Greater bandwidth allows for increased resolutions, higher refresh rates, and greater color depth.
• Automated testing:

• Minimizes user intervention when conducting time-consuming testing.
• Reduces the time required to conduct testing.

• Selective testing:

• Performs fully-automated testing for transmitter measurements.
• Allows selecting test individually or in groups.
• Avoids repeated testing through accurate and reliable results from a single run.

• Quick testing:

• One-button selection of multiple tests ensures faster testing.
• One-button MHT report format saves time.

• Complete Solution: Complete compliance solution with an elaborate test fixture and support for SMA probing provides a cost-effective
way to perform compliance testing.

• Customize the setup:

• Modify the test setup according to the DUT configuration.
• Run tests using different record lengths.
• Run test measurements using more than one signal.

• Detailed test reporting:

• Provides a Pass/Fail summary table.
• Provides Compliance report.
• Provides margin details on each test.
• Provides all results, grouped by features.
• Provides a consolidated report for all tests.

Getting started
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• Provides additional information such as skew, alignment, and signal type selected for each measurement.

Application directories and usage
The application directory and associated files are organized as follows: 

The following table lists the default directory names and their usage.

Table 3: Application directories and usage

Directory names Usage

InstallDir\TekExpress\TekExpress DisplayPortTx Contains the application and associated files

TekExpress DisplayPortTx\Bin Contains the miscellaneous DisplayPort Tx application libraries

TekExpress DisplayPortTx\Compliance Suites Contains compliance-specific files

TekExpress DisplayPortTx\Examples Contains various support files

TekExpress DisplayPortTx\ICP Contains instrument and DisplayPort Tx application-specific
interface libraries

TekExpress DisplayPortTx\Images Contains Tektronix log images

TekExpress DisplayPortTx\Lib Contains utility files specific to the DisplayPort Tx application

TekExpress DisplayPortTx\Plugins Contains DUT Automation related plug-ins.
TekExpress DisplayPortTx\Report Generator Contains style sheets for report generation
TekExpress DisplayPortTx\Setup Contains setup files

TekExpress DisplayPortTx\Tools Contains instrument and DisplayPort Tx application-specific files

Getting started

18



See Also
View test-related files

File name extensions
The TekExpress DisplayPort Tx application uses the following file name extensions:

File name extension Description

.TekX Session files are saved in this format but the extensions may not be displayed.

.xml The encrypted XML file that contains the test-specific configuration information.

The log file extension is also .xml

.wfm The test waveform file.

.mht Test result reports are saved in this format by default. Test reports can also be
saved in HTML format.

.pdf Test result reports.

Application help document.

.csv Report is generated in .csv format.

See Also
View test-related files

Application directories and usage

Before you click start
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Operating basics

Start the application
To run the DisplayPort Tx application, do any of the following: 

• From the TekScope Analyze menu, select Analyze > TekExpress DisplayPort Tx.
• Double-click on any DisplayPort saved session file.

While running the application, you can switch between the oscilloscope screen and DisplayPort Tx by clicking the desired window. To keep
the application window on top, select Keep On Top from the Options menu.

Note: If the application was not terminated properly during the last use, a dialog box asks to recall the previously unsaved
session.

Application panels overview
TekExpress DisplayPort Solution uses panels to group related configuration, test, and results settings. Click any step button to open the
associated panel. A panel may have one or more tabs that list the selections available in that panel. Controls in a panel can change
depending on settings made in that panel or another panel.

Table 4: Application panels

Panel name Purpose

Setup The Setup panel allows you to configure the test setup. Use this panel to:

• Select DUT parameters.

• Select the test(s).

• Set acquisitions tab parameters for selected tests.

• Set configuration tab parameters.

• Select preferences tab parameters.

Status View the acquisition status and analysis status of the selected tests, and view test logs.

Results View a summary of test results and select result viewing preferences.

Reports You can find the reports, save reports as specific file types, specify report naming conventions, select
report content to include (such as summary information, detailed information, user comments, setup
configuration, application configuration), and select report viewing options.

Exit the application
Use the following method to exit the application:

Note: Using other methods to exit the application results in abnormal termination of the application.

Operating basics
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1. Click  on the application title bar.
2. Do one of the following:

• If you have an unsaved session or test setup open, you will be asked to save it before exiting. To save it, click Yes. Otherwise click
No. The application closes.

• A message box appears asking if you really want to exit TekExpress. To exit, click Yes.

Note: To minimize the application, click  on the application title bar.

Application controls and menus

Application controls
This section describes the application controls.

Table 5: Application controls descriptions

Item Description

Options menu Menu to display global application controls.

Panel Controls that open panels for configuring test settings and options.

Command buttons Button that initiates an immediate action such as the Start, Stop, Pause, and Clear
command buttons

Start button Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set.

Stop button Use the Stop button to abort the test.

Pause \ Continue button Use the Pause button to temporarily pause the current execution. When a test is paused,
the button name changes to "Continue".

Clear button Use the Clear button to clear all existing measurement results. This button is available only
on the Results panel.

Minimise button Minimises the application.

Table continued…
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Item Description

Close button Exits the application.

Application window move icon Place the cursor over the three-dot pattern in the upper left corner of the application
window. When the cursor changes to a hand, drag the window to the desired location.

Options menu
The Options menu is located in the upper right corner of the application.

Figure 1: Options menu

The options menu has the following selections: 

Menu Function

Default Test Setup Opens an untitled test setup with defaults selected

Open Test Setup Opens a saved test setup

Save Test Setup Saves the current test setup selections

Save Test Setup As Creates a new test setup based on an existing one

Open Recent Displays a menu of recently opened test setups to select from

Instrument control settings Shows the list of instruments connected to the test setup and allows you to locate and
refresh connections to connected instruments

Keep On Top Keeps the TekExpress DisplayPort Tx utility on top of other open windows on the desktop

Email settings Use to configure email options for test run and results notifications

Table continued…
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Menu Function

Help Displays TekExpress Help

About TekExpress • Displays application details such as software name, version number, and copyright

• Provides access to license information for your DisplayPort Tx installation

• Provides a link to the Tektronix Web site

See Also
Application controls

Email settings
Use the email settings utility to configure email notifications if you want DisplayPort application to notify you when a tests completes,
produces an error, or fails. Select the type of test run information to be included in the notification, such as test reports and test logs, the
email message format, and the email message size limit.

Note: Recipient email address, sender’s address, and SMTP Server are mandatory fields.

See Also
Options menu

Select analysis and test notification preferences

Instrument control settings
The Instrument Control Settings dialog box shows the list of resources found on different connections. It serves two purposes: 

• Discovers the connected instruments
• Confirms the instrument connection setup

Operating basics
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Use the Instrument Control Settings feature to search for connected instruments and view instrument connection details. Connected
instruments displayed here can be selected for use in the Global Settings section of the Setup panel’s Configuration section. See step 2 of
Configure tests for details.

See Also
Options menu

Panels

About panels
TekExpress DisplayPort Tx has the following main panels:

Table 6: Application panels

Panel name Purpose

Setup The setup panel allows you to configure the test setup. Use this panel to:

• Select device parameters.

• Select the test(s).

• Select acquisitions parameters for selected tests.

• Configure the selected tests.

• Select analysis and test notification preferences.

Status View the acquisition status and analysis status of the selected tests, and view test logs.

Results View a summary of test results and select result viewing preferences.

Table continued…
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Panel name Purpose

Reports Browse for reports, save reports, specify report naming conventions, select content to include (such
as summary information, detailed information, user comments, plot images, setup configuration), and
select other report viewing options.

See Also
Application controls

Setup panel
The Setup panel has numbered tabs to guide you through the test setup process:

1. DUT

Figure 2: DUT tab, Compliance view
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Figure 3: Advanced view

2. Test Selection
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Figure 4: Test Selection tab

3. Acquisitions

Figure 5: Acquisitions tab

4. Configuration
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Figure 6: Configuration tab (Measurements)

5. Preferences

Figure 7: Preferences tab

By default, only the DUT, Test Selection, Acquisitions, and Preferences tabs are displayed. The Configuration tab is only available if you
select the Advance View option in the DUT tab. Otherwise, configuration settings for tests selected in the Test Selection tab are available
from the Configure button on the Test Selection tab.

Options selected in a preceding tab affect options available in the next tab down. For example, Device Profile settings affect the list of tests
available for selection in the Test Selection tab. However, you can switch between the tabs in any order if you need to modify your test
parameters.
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For more information on using the Setup panel, see About setting up Tests. 

See Also
About panels

Status panel
Use the Status panel to track the progress of the test measurements. The Status panel has two tabs: the Test status on page 76 tab
displays the acquire status and the analysis status of the tests as they are being executed; the Log view on page 77 tab (shown below)
displays a view of the test log.

Figure 8: Test Status view

For more information on using the Status panel, see View the progress of analysis. 
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See Also
About panels

Results panel
When a test completes running, the application switches to the Results panel to display a summary of test results. Set the viewing
preferences for this panel from the Preferences menu in the upper right corner. Viewing preferences include showing whether a test
passed or failed, summary results or detailed results, and enabling wordwrap. For information on using this panel, see View test results. 
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See Also
About panels

Reports panel
Use the Reports panel to browse for reports, name and save reports, select report content to include, and select report viewing options.

For information on setting up reports, see Select report options. For information on viewing reports, see View a report. 
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See Also
About panels
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Saving and recalling test setups

About test setups
TekExpress DisplayPort Tx opens with the default setup selected. Run a test before or after saving a setup. When you save a setup,
the test information, such as the selected oscilloscope, general parameters, acquisition parameters, measurement limits, waveforms, and
other configuration settings, are all saved under the setup name. Use test setups to:

• Run a saved test in pre-recorded mode.
• View all the information associated with a saved test, including the Log file, the history of the test status as it executed, and the results

summary. For details, see Recall a saved test setup.
• Create a new test setup based on an existing one.

See Also
About setting up tests

Save a test setup

Delete a test setup

Save a test setup
You can save a test setup before or after running a test. You can create a new setup from an already opened setup, or using the default
setup. When you select the default test setup, all parameters are set to the application's default value.

To Save a test setup, follow the steps:

1. Select the desired options in the Setup panel.
2. Select the desired report options.
3. If desired, run the test to be sure that it captures the information you want. If it does not, edit the parameters.
4. From the Options menu, select Save Test Setup to save the setup.

See Also
About setting up tests

Test setup overview

About configuring tests

Delete a test setup

Recall a saved test setup
To Recall a saved test setup, do the following: 

1. From the Options menu, select Open Test Setup.
2. In the File Open dialog box, select the desired setup from the list and then click Open. Setup files are located at X: \DisplayPort folder.

See Also
About test setups
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Create a new test setup based on an existing one

Delete a test setup

Create a test setup from default settings
To create a test setup using default settings, follow the steps:

1. Select Options > Default Test Setup. For default test setup, the parameters are set to the application’s default value.
2. Click application Setup and set the parameters.
3. Click application Reports and set the report options.
4. Optional: Click Start to run the test and verify that it runs correctly and captures the specified test information and reports. If it does not,

then edit the parameters and repeat this step until the test runs to your satisfaction.
5. Select Options > Save Test Setup. Enter the file name and click Save. The application saves the file to X:\DisplayPort

folder\<session_name>.

Recall a saved test setup
To Recall a saved test setup, do the following:

1. Select Options > Open Test Setup.

2. Select the setup from the list and click Open. Setup files are located at X: \DisplayPort folder.
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Create a new test setup using an existing one
To create a new test setup using an existing one, follow the steps:

1. From the Options menu, select Open Test Setup.
2. In the File Open dialog box, select the desired setup from the list and then click Open.
3. Modify the parameters as desired.
4. From the Options menu, select Save Test Setup As.
5. In the File Save As dialog box, enter a test setup name and then click Save.

See Also
About test setups

Delete a test setup

Delete a test setup
Delete test setups that you no longer need. This also removes them from the test setup list in the Options menu.

1. Make sure the setup you want to delete is not currently selected in TekExpress DisplayPort. To save any of the test information in the
test setup folder, save it to a location other than the DisplayPort folder in My TekExpress folder.

2. Navigate to the DisplayPort on the X: drive and locate the test setup files you want to delete.

3. Delete both the test setup folder and the test setup file (for example,  and , respectively).

See Also
View test-related files

About test setups
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Setting up and configuring tests

About setting up tests
Set up tests using the tabs in the Setup panel. Settings in the DUT tab use a top-down, left-to-right logic flow, so that any parameter that
affects or acts as a filter for other parameters appears either to the top of or to the left of the affected parameters.

Test options include two views, Compliance and Advanced (selected in the DUT tab of the Setup panel), and two modes, Compliance and
User Defined (selected in the configuration settings of the Setup panel). The selected view determines where the test configuration settings
are displayed. The selected mode determines whether you can change test configuration settings to include those that are noncompliant.
The level of user intervention required depends on the DUT Automation setting and Acquisition parameters. 

• Compliance View selected with Compliance Mode: View configuration options in the Test Selection tab of the Setup panel. Tests
will run automatically with little or no user intervention. You will not be able to change test parameters to anything that deviates from
the compliance standards. The only test configuration parameters that you can change in this mode are the Real Time Scope and the
Digital Filters (DSP), both under Global Settings.

• Compliance View selected with User Defined Mode: View configuration options in the Test Selection tab of the Setup panel. Tests will
run automatically but you will be able to change some test parameters before starting the test.

• Advanced View selected with Compliance Mode: View configuration options in the Configuration tab of the Setup panel. Tests will
run automatically with little or no user intervention. You will not be able to change test parameters to anything that deviates from the
compliance standards. The only configuration parameters you can change in this mode are the selected Real Time Scope and the
Digital Filters (DSP), both under Global Settings.

• Advanced View selected with User Defined Mode: View configuration options in the Configuration tab of the Setup panel. Tests will
run automatically but you will be able to change some test parameters before starting the test.

DisplayPort
Supported tests

• Eye Diagram:

This test evaluates the timing and amplitude support of the overall DisplayPort system objective of Bit Error Rate in data transmission.
Eye diagram is plotted to evaluate the timing and amplitude parameters.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Non Pre-Emphasis Level Verification:

This test is performed to ensure that the system budget is followed and ensures that the level settings are monotonic in nature.
Monotonicity helps the sink can relay on the source to incrementally increase upon by the sink.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Pre-Emphasis Level Verification and Maximum Peak-to-Peak Differential Voltage Testing:

This test measures the pre-emphasis of the Source waveform, by measuring the peak to peak differential amplitude. Comparisons are
made for the Level 0 transition state as well the as non-transition levels. Maximum peak to peak amplitude is also measured.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• HBR2/HBR3 Level and Equalization Verification Testing:

This test evaluates the pre-emphasis of the Source waveform. This is done by measuring the first and fifth harmonics for the different
settings of the signal. Calculations are based on ratio of first and fifth harmonic combinations.

• Inter-Pair Skew Test:

Setting up and configuring tests

36



This test evaluates the skew, or time delay, between the differential data lanes.

This measurement can be run using differential probe as well as single-ended probe. This measurement can be run only with 2 lanes
and 4 lanes connection.

• Intra-Pair Skew Test:

This test evaluate the skew or the time delay, between the respective sides of a differential data lane.

This measurement can be run using single-ended probe. This measurement can be run only with 1 lane, 2 lanes, and 4 lanes
connection.

• AC Common Mode Noise:

This test evaluates the AC common mode noise (unfiltered RMS) of the differential data line.

This measurement can be run using single-ended probe. This measurement can be run only with 1 lane, 2 lanes, and 4 lanes
connection.

• Non ISI Jitter Measurements:

This test evaluates the amount of Non-ISI jitter accompanying the data transmission.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Total Jitter and Random Jitter (RJ/DJ) Measurement:

This test evaluates the total jitter at 10e-12 for RBR, HBR and HBR2 and 10e-9.5 for HBR3. This can be measured explicitly at this rate
or through an approved estimation technique.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Main Link Frequency Compliance:

This test ensure that the average data rate under all conditions does not exceed minimum or maximum as set by the standard.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Spread Spectrum Modulation Frequency:

This test evaluates the frequency of the SSC modulation.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• Spread Spectrum Modulation Deviation:

This test evaluates the range of SSC down-spreading of the transmitter signal.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

• dF/dt Spread Spectrum Deviation HF Variation:

This test verifies SSC profile and it does not include any frequency deviation which would exceed 1250ppm/uSec.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane, 2 lanes,
and 4 lanes connection.

Dual Mode tests
• Dual Mode TMDS Clock:

This test verifies the duty cycle of the TMDS clock waveform of a source operating in dual mode.

This measurement can be run only using differential probe. Measurement can be run with 1 lane, 2 lanes, and 4 lanes connection.
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• Dual Mode Eye Diagram:

This test performs the eye diagram measurement and finds the timing variables and amplitude trajectories for a dual mode source
device.

This measurement can be run only using differential probe. Measurement can be run only with 4 lanes connection.

Aux Channel tests
• AUX Manchester Channel Eye Testing:

Checks if AUX Manchester channel eye waveform timing variables and amplitude trajectories support DisplayPort system.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane connection.
• AUX Channel Eye Sensitivity Test:

Evaluates the sensitivity to the AUX CH EYE opening of a DUT.

This measurement can be run using differential probe as well as single-ended probe. Measurement can be run with 1 lane connection.
This measurement is visible only when DUT automation is not manual.

• Inrush Test:

Evaluate the Inrush energy at the power supply Input of a power consuming DUT.

This measurement can be run using single-ended probe. Measurement can be run with 1 lane connection.
• AUX Slew Rate Test:

This test evaluate the AUX signaling edge rates to minimize crosstalk to main link signals.

See Also
Before you click start

Deskew channels

About running tests
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Equipment connection setup
To run tests, you need the following equipment (for details, see Minimum System Requirements): 

• A supported Tektronix oscilloscope
• TCA-SMA or Differential Probes (for example, P7313SMA)
• The device under test
• Test fixtures

The following diagrams show different setups. To view a diagram, click the one for the desired setup.

AUX Channel Eye diagram using VTM fixture and DP AUX with single-ended probes

AUX Channel Eye diagram using VTM fixture and DP AUX with differential

probes
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AUX Channel Eye diagram using Wilder fixture and DP AUX with single-ended probes

AUX Channel Eye diagram using Wilder fixture and DP AUX with differential probes
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AUX Channel Sensitivity test using VTM fixture and DP AUX with single-ended probes

AUX Channel Eye diagram and Sensitivity test using Type-C dongle and DPC with single-ended probes
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AUX Channel Eye diagram and Sensitivity test using Type-C dongle and DPC with differential probes

AUX channel Eye diagram and Sensitivity test using VTM fixture and DPR-100 with single-ended probes
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AUX Channel Eye diagram and Sensitivity test using VTM fixture and DPR-100 with differential probes

AUX Channel Eye diagram and Sensitivity test using Wilder fixture and DPR-100 with single-ended probes
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AUX Channel Eye diagram and Sensitivity test using Wilder fixture and DPR-100 with differential probes

DisplayPort setup with DP-AUX controller and differential probes

DisplayPort setup with DP-AUX controller and single-ended probes
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DisplayPort setup with DPR-100 and differential probes

DisplayPort setup with DPR-100 and RF Switch
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DisplayPort setup with DPR-100 and single-ended probes

DisplayPort setup for Dual Mode test
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Inrush setup diagram

DisplayPort setup for Type-C with GRL controller and Type-C fixture
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For testing ML0 and ML3 signals (i.e., Pins A10-A11, B10-B11), connect recommended DC blocks at the output of the test fixture.

DisplayPort setup with Type-C and RF Switch

DisplayPort setup for Type-C with DPR-100 using differential probes for Alpine Ridge DUTs
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DisplayPort setup for Type-C with RF Switch for Alpine Ridge DUTs

DisplayPort setup with DPR 100 using Type-C with single ended probes for Alpine Ridge DUTs
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DisplayPort Type-C setup with DPC and dongle with DPR-100

See Also
View connected instruments

About setting up tests

Pre-Run checklist

Deskew channels
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View connected instruments
Use the Instrument Control Settings dialog box to view or search for connected instruments required for the tests. The application uses
TekVISA to discover the connected instruments.

To refresh the list of connected instruments:

Note: The correct instruments required for the test setup must be connected and recognized by the application before running the
test.

1. From the Options menu, select Instrument Control Settings.
2. In the Search Criteria section of the Instrument Control Settings dialog box, select the connection types of the instruments to search

for.

Instrument search is based on the VISA layer but different connected cables determine the resource type, such as LAN, GPIB, USB.
For example, if you choose LAN, the search will include all the instruments supported by TekExpress that are communicating over the
LAN. If the search does not find any instruments that match a selected resource type, a message appears telling you that no such
instruments were found.

3. Click Refresh. TekExpress searches for connected instruments.
4. After searching, the dialog box lists the instrument-related details based on the search criteria you selected. For example, if you select

LAN and GPIB as the search criteria, the application checks for the availability of instruments over LAN, then GPIB.

The details of the connected instruments are displayed in the Retrieved Instruments table. The time and date of instrument refresh are
displayed in the Last Updated field.

See Also
Configure tests

Equipment connection setup
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Individual test configuration

To change any of the configuration for the individual test, change the parameters in the User Defined Mode and run the test. For example
in case of Eye diagram, to change the Worst case cable, CTLE cable, and few more parameters, you can do them in the User Defined
Mode.

However in Compliance mode also, you can change the configuration.

In CTLE for HBR3, Zero cable, and Worst cable the options are between 0 db to -9 db. You can select any of the CTLE setting to perform
the equalization in SDLA. If you are not sure of what CTLE to choose, you can select All in Zero cable drop-down. The SDLA will in turn
find the optimal CTLE equalization.

Worst cable:

To change any of the configuration for the individual test, change the parameters in the User Defined Mode and run the test. For example
in case of Eye diagram, to change the Worst case cable, CTLE cable, and few more parameters, you can do them in the User Defined
Mode.

You can change the configuration in Compliance mode too. In CTLE for HBR3, Zero cable, and Worst cable the options are between 0 db
to -9 db. You can select any of the CTLE setting to perform the equalization in SDLA. If you are not sure of what CTLE to choose, then
select All in Zero cable drop-down. The SDLA will in turn find the optimal CTLE equalization.

Test setup overview
Test setup includes acquisition and configuration parameters, but you can also select report options when you set up tests. Below are
listed the main test setup steps. Most test setup options are located in the Setup panel, but options specific to reports are located in the
Reports panel. 

1. Select settings for the device under test.
2. Select one or more tests.
3. Select acquisitions.
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4. Configure tests.
5. Select analysis and test notification preferences.
6. Select report options.

See Also
Before you click start

Pre-Run checklist

About running tests

Select DUT parameters
Use the Setup panel DUT tab settings to select settings for the device under test. These options affect the list of available tests in the Test
Selection tab. 

Note: If the connected DUT does not have certain capabilities, then you have to select the DUT options accordingly and run the
test. For example, if the DUT does not support SSC, then you should select SSC disable option in the drop-down of the DUT
panel.

1. In the Setup panel, click the DUT tab.
2. Select the global DUT settings that will apply to all tests for the current session:

a. If needed, in the DUT ID field, enter the ID for the device. The default value is DUT001. The name in this field appears on test
reports.

b. (Optional) To add comments that will appear at the top of the test report (if the Include User Comments option is selected in the

Report options), click the note pad icon ( ) to the right of the DUT ID field and specify a comment of up to 256 characters.
c. Select whether to use a pre-recorded waveform file or acquire a live waveform for testing.
d. For View, select Compliance or Advanced.

Setting up and configuring tests
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Note: If you select Advanced View, the configuration settings are included in the Setup steps as step 4. If you select
Compliance View, the configuration step is not included as a separate step. Access the configuration parameters for the
selected tests from the Configure button in the Test Selection tab.

e. Displays DisplayPort as the default Device.
f. Select the CTS version.
g. Select Standard or Type C as the Connector.

If Type C is selected, the DUT Automation controller is enabled in the drop-down. You can select either GRL as the DUT
Automation controller.

Click Setup button, Alt Mode Settings popup appears.

When Use Alt Mode controller is

• Selected: The application uses the available alt mode controller during the execution.

It enables Put DUT in Alt Mode during Run.

• When Put DUT in Alt Mode during Run is selected, the application will put the DUT in alt mode every time run button is
pressed.

• When Put DUT in Alt Mode during Run is unselected, the application assumes that the DUT is already in alt mode.
• Unselected: The application will not use the alt mode controller (functions same as in manual mode of operation).

Select the DUT Automation as 'Manual', if you want to put the DUT in the Alt mode using some other device, instead of the GRL
controller. To control the DUT, the HPD-IRQ from the Alt mode controller signal must be detected.

Select the DUT automation as 'Dongle', if you want to put the DUT in Alt mode using the dongle.

Note: GRL Alt Mode controller is used to put the DUT in ALT mode and to issue HPD-IRQ signal.

3. Below listed are the Device Profile options.

Table 7: Device Profile options:

Setting Description / Option

Data Rates Select the data rates to include in the tests.

• RBR: Reduced Bit Rate (1.62 Gb/S)
• HBR: High Bit Rate (2.7 Gb/S)
• HBR2: High Bit Rate 2 (5.4 Gb/S)
• HBR3: High Bit Rate 3 (8.1 Gb/S)

Table continued…
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Setting Description / Option

Voltage Swing All voltage levels are selected by default. At least one voltage swing level
must be selected at all times. 1200 mV is unselected by default.

Pre-Emphasis Levels All pre-emphasis levels are selected by default. At least one pre-emphasis
level should be selected. 3 is unselected by default.

SSC Only one of the following options can be selected at a time for Spread
Spectrum Clocking:

• SSC Enable: When selected, only the acquisitions that support the SSC
On condition will be tested.

• SSC Disable: When selected, only the acquisitions that support the
SSC Off condition will be tested.

• Both: When selected, the tests will run under both conditions for those
acquisitions that support both.

Lane Setup To access this field, you have to click Multi-Lane Setup button. Select the
desired number of test lanes to use for this test session. The link width
shown here determines the number of test lanes you can select.

• 1 Lane: When selected, only one lane can be used.

• 2 Lanes: When selected, any one lane or two lanes can be used.

• 4 Lanes: When selected, only a lane or two lanes or four lanes can be
used.

Selected Lanes Displays the test lanes selected for the test session

To change lanes selected for testing, click Setup .

a. In the Test Lane Setup dialog box, select the desired number of lanes
from the Link Width drop-down list.

b. To select the lanes to use, click the corresponding lane buttons:

• To select all four lanes at once, click Select All. If you select this,
select 4 Lanes from the Link Width drop-down list.

• To deselect all selected lanes, click Deselect All.
• If you select 1 Lane, only one lane can be used.
• If you select 2 Lanes, any one lane or two lanes can be used.
• If you select 4 Lanes, only a lane or two lanes or four lanes can be

used.
c. Click OK.

Your selections display in the Lane Setup section of the DUT tab.

Table continued…
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Setting Description / Option

Use Switch Matrix Select to use the Switch Matrix support.

Note: Use Switch Matrix checkbox is enabled only when
you connect the RF switch to the device, configure it in the
configuration panel, select 4 lane in multi-lane, and connects the
single ended probes.

Click Setup button to configure RF Switch.

In Switch setup group box, DPSwitchDefaultconfig is selected by default in
the DP configuration.

You can cross-check the physical connection against this configuration and
update the configuration as required.

For more details, refer to Switch Matrix application.

Table continued…
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Setting Description / Option

DUT Automation Displays the type of DUT control currently in use. The user has to configure
the settings.

• Manual (default): You will be prompted to configure the DUT manually
during the test. You can change this to Custom if needed.

• DP AUX: Select this option to configure the DUT using DP AUX.
• DP Nvidia: Select this option to use the Tektronix DP-AUX controller

with NVIDIA chip/DUT.
• DPR-100: Select this option to configure the DUT using Unigraf

DPR-100.

When DPR-100 is selected and when you click Setup. DPR-100 Setup
pop-up appears for the first time. Enter the valid license key to use
DPR-100.

You can browse and select the location of Standard and Type C script
file if you do not want to use the default files.

• TenLira DPR-100:

Select this option to configure the DUT using TenLira. Click on setup
to configure DUT IP address. Make sure DUT and oscilloscope are on
same network.

Note: This option is available only when Type C connector is
selected.

Also run “C:\ Program Files\Tektronix\DP
TenLira\TekDispTenLiraDutController.exe” on the DUT and press test
connection to ensure the link is established between oscilloscope and
the DUT.

Make sure that DPR-100 license is enabled.

Table continued…
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Setting Description / Option

Signal Validation • Prompt if validation fails: When selected, user is prompted if pattern
validation fails. The user will be given the option to Reacquire, Use
Anyway, Skip and Abort the execution.

• Skip test if validation fails: When selected, it will skip the
corresponding test(s) if pattern validation fails.

• Skip validation: When selected, skips the validation for all the patterns.
• Validate pattern but use pattern as is: Select to validate the pattern. If

the validation fails, the application retries the link training for 3 times. If
the validation fails even after 3 times, then it will use the pattern as is.

You can choose the required parameter for signal validation.

Note: Minimum one parameter should be selected.

See Also
Select a test

About setting up tests

Use pre-recorded waveforms for analysis

Acquire live waveforms for analysis

Select a test
Use these instructions to select the tests to run on the connected DUT. 

1. In the Setup panel, click the Test Selection tab.
2. All tests are selected by default. Click Deselect All if you do not want to run all tests.
3. Select the desired test(s):

• To select all required tests, click the Select Required button.
• To select all tests in the list, click the Select All button.
• To select one or more tests, select the check boxes for the tests.

Test selection controls

Table 8: Setup panel test controls

Button Description

When the View type selected in the DUT tab is Compliance, this button opens a
configuration section for the selected test. If the View type is Advanced, this button is
not displayed.

Displays the schematic document for the selected test. Use to verify the test setup before
running the test.

Deselects all tests in the table.

Table continued…

Setting up and configuring tests

58



Button Description

Selects tests required for compliance and deselects all other tests currently selected.

Selects all tests in the test selection panel.

Note: For HBR2 and HBR3 speed: Total Jitter, and Random Jitter tests are dependent on selection of Eye diagram tests.

See Also
Select acquisitions

About setting up tests

Selecting acquisitions

About acquisitions
Use the Acquisitions tab in the Setup panel to view acquisitions parameters for the selected tests.

The information on the Acquisitions tab is specific to the tests selected in the Test Selection tab and gets updated every time you change
the selected tests. Options available also depend on whether you selected to acquire live waveforms or use pre-recorded waveform files in
the DUT tab.

The top section of the Acquisitions tab is the source selection area. The information that appears here depends in part on which type of
setup you are using. 

Below the source area is the test acquisition and mapping table. If the same acquisition can be used for multiple tests, then the test
acquisitions table will show these rows as merged. Additional acquisition options appear below the table.
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Table 9: Acquisitions table

Column name Function

Test Name Displays the name of the selected test that the acquisitions apply to. One or more tests can
perform the same acquisitions.

Acquisition Displays the acquisition type for each measurement.

(Parameter Name)

Note: Parameter name is displayed
only when Show Acquire
parameter is enabled.

Displays a column for each parameter available in the test. Cells in the column might
display the status of whether the measurement was included in the measurement,
supported by the test, or the parameter setting.

Waveform FileName Lists the name of the waveform files used for the test. Select waveform files by clicking the
button in the row. This allows you to select any waveform file using the standard File Open
window. This applies to pre-recorded waveforms only.

Acquisition and Save Options All waveforms are saved before analysis.

• Save All Waveforms: When selected saves all the waveforms. When it executes, all
waveforms will be saved.

• Delete All Waveforms After Analysis: As soon as the execution is over, it deletes all the
waveforms.

Show Acquire Parameters When enabled displays the parameter name.
Embed/De-embed Filter Browse to the location of the filter file to embed/de-embed. All filter files are available in this

location, C:\Users\Public\Tektronix\TekApplications\DisplayPort\Filters folder.

Note: De-embed feature is applicable in live mode only.

DC Voltage DC voltage settings for acquiring the waveform.

Note: For DP++ tests, you must select sources for Clock lane and Data lanes. For Aux tests, select sources for AUX lane.

See Also
Select acquisitions

About setting up tests

Set acquisition tab parameters
Use the Acquisitions tab in the Setup panel to view and set acquisition parameters for selected tests. Options available depend on whether
you are using a live waveform or a pre-recorded waveform file. 

1. In the Setup panel, click the Acquisitions tab.
2. If you selected to use a pre-recorded waveform file, in the Acquisitions table, scroll to the Waveform FileName column. For each

acquire type row, click the ellipsis button ( ) and select the desired waveform file or files.
3. If you selected to use live waveforms, then the lane and channel selection tables are displayed near the top of the tab. The selections

displayed are based on the available probe setup.
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• To see which probes are connected to which channels, click View Probes.
• To refresh the probe configuration information displayed after changing any probes, click View Probes and then click Refresh in

the Probe Configuration dialog box.
• To change a lane source, click in the Source column and select a channel from the drop-down list.

4. Select any other desired acquisition options.

See Also
Configure tests

About setting up tests

Test setup overview

Acquisitions parameters
Available parameters depend on the selected mode (Compliance or User Defined) and the type of waveform being used, live or
pre-recorded. 

Table 10: Acquisitions options

Option Description

Show Acquire Parameters When selected, the acquisition parameters for each test display in the Acquisitions table
columns.

See Also
About acquisitions

Select acquisitions

Use pre-recorded waveforms for analysis
Use pre-recorded waveform files to run saved tests or to run a new test using a saved waveform from another test.

Run a test in pre-recorded mode.

Run a saved test or new test using a pre-recorded waveform file. 

1. Open a saved test setup or create a new one.

Note: If using a saved test and you do not want to overwrite the previous data, save this test setup using the Save As option
before proceeding.

2. In the Setup panel, select the DUT tab and then select Use pre-recorded waveform files. (This selection adds the Waveform
FileName column to the Acquisitions table in the Acquisitions tab.)

3. Change any other DUT parameters as desired.
4. In the Test Selection tab, select the desired test(s).

5. In the Acquisitions tab, locate the row for the desired test. In the Waveform FileName column, click the ellipsis button ( ) and then
select a single waveform file or multiple waveform files.

6. Perform any additional test needed, such as test configuration, and then click Start.
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See Also
Before you click start

Pre-Run checklist

About acquisitions

Running measurements using pre-recorded waveforms
1. Go to DUT panel and select the mode as Use pre-recorded waveform files.

2. Select the DUT settings based on waveforms available for running measurements. Ex: If only SSC waveforms are present then need to
select SSC as SSC Enable.

3. Go to Test Selection panel and select desired tests which you want to run using those waveforms.
4. Go to Acquisition panel and make sure all the desired tests are available here.
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5. Click on the icon present in ‘Waveform FileName’ column.
6. Make sure all the waveforms you have has proper naming convention. In case of differential signals, waveforms should have naming

convention similar to this‘ Lane0_HBR_D10.2_SSC_0dB_800mV_20_50_diff_R1’ and in case of single ended signals, waveforms
should have naming convention similar to this ‘Lane0_RBR_PRBS7-Single Ended_SSC_0dB_600mV_20_50_SE_pos_R1'. Refer to
Waveform naming convention.

7. Select all the waveforms required for running test (In order to understand what all waveforms user has to select for running each
measurement, load any existing session and switch to pre-recorded mode then go to acquisition panel).

8. Click Start button.
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9. If any of the tests has not run completely and report has not generated then please cross check whether you have selected the
required DUT parameters in order to run in compliance mode. In this case please select appropriate DUT settings and waveforms then
re-run the test.

Figure 9: Waveform naming convention

Acquire live waveforms for analysis
Use these instructions to set up acquisition for a live waveform. 

1. Open a saved test setup or create a new one.
2. In the Setup panel, select the DUT tab, enter the desired DUT ID in the corresponding field and then select Acquire live waveforms.
3. Select other DUT parameters as desired.
4. In the Test Selection tab, select the desired test(s).
5. In the Acquisitions tab, do any of the following that apply:

• Select the data sources for the lanes.
• Select other desired acquisitions parameters.

6. Configure the tests if you have not done so already, and then click Start to run the test.

Note: For DP++ tests, you must select sources for Clock lane and Data lanes. For Aux tests, select sources for AUX lane.

See Also
About acquisitions

Select acquisitions
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Configuring tests

About configuring tests
Use configuration settings to view and edit the analysis parameters for selected tests.

The Configuration tab shows Global parameters and Measurement parameters. Global parameters are common for all tests. Measurement
parameters are specific to the test selected in the tree view section of the configuration settings. Test-specific parameters can include
acquisition, analysis, and limit parameters, and certain oscilloscope settings. Whether you can configure settings depends on which mode
you selected, Compliance or User Defined. For more information, see About setting up tests. 

Note: If you selected the Compliance View in the DUT tab, you will access test configuration settings using the Configure button
in the Test Selection tab. If you selected Advanced View in the DUT tab, access test configuration settings from the Configuration
tab in the Setup panel.

See Also
Configure tests

About running rests

Configure tab parameters
Use these instructions for configuring tests. 

1. Do one of the following:

• If you had selected Compliance View in the DUT tab, then in the Test Selection tab, select the desired test in the list and then click
Configure.

Note: To return to test selection from the configuration section, click the Test Selection button.

• If you selected Advanced View, click the Configuration tab in the Setup panel.

Note: You cannot change test parameters that are grayed out.

2. Modify parameter settings as desired:

• To use Compliance Mode values, select Compliance Mode.

Note: You cannot change test parameters in Compliance mode, but you can view the selected parameter settings.

• To select the instrument for testing, click Global Settings. In the Instruments Detected section, click the drop-down arrow and then
select the desired instrument from the list. If you do not see the desired instrument in the list, refresh the list.

See Also
Select analysis and test notification preferences

Before you click start

About setting up tests

Common test parameters and values
The following table lists the measurement parameters common to most tests. 
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Table 11: Common parameters and values

Parameter type Parameter and default value

Mode Determines whether test parameters are in compliance or can be edited

• Compliance: Most test parameter values cannot be edited.

• User Defined: Most test parameter values can be edited.

Global Settings These settings apply to all tests selected for the current session.

• Real Time Scope: Specifies the oscilloscope used for tests.

Measurements Shows the parameter settings for the test selected in the tree view section.

Limits Shows the upper and lower limits for the applicable measurement using different types of comparisons. In Compliance
Mode, allows you to view the measurement high and low limits used for the test selected in the tree view of the
Measurements tab. When running tests in User Defined Mode, you can edit the limit settings in the Limits Editor.

Figure 10: When running tests in User Defined Mode, the cells in the Limits Editor table are active for editing so you can change parameters.

See Also
Configure tests

Select acquisitions

Configure email settings
Use the Email Settings utility to get notified by email when a measurement completes, or produces any error condition. Follow the steps to
configure email settings:
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Figure 11: Email Settings

1. From the Options menu, select Email Settings to open the Email settings dialog box.
2. (Required) For Recipient email Address(es), enter your email address. To include multiple addresses, separate the addresses with

commas.
3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name

followed by an underscore followed by the instrument serial number, then the @ symbol and the email server used. For example:
DPO72004C_B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location, and
the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

Note: If any of the above required fields are left blank, the settings will not be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

• Reports: Select to receive the test report with the notification email

• Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you
want to receive the full log or just the last 20 lines.

6. In the Email Configuration section, select as desired:

• Select the message file format to send: HTML (the default) or plain text.
• Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is

5 MB.
• To limit the number of attempts the system makes to send a notification, enter the number in the Number of Attempts to Send

field. The default is 1. You can also specify a timeout.
7. Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email

notifications
8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close to exit the Email Settings dialog box.

See Also
Configure tests
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Select analysis and test notification preferences

Set preferences tab parameters
Use the Preferences tab to set the application action on completion of a measurement:

Table 12: Preferences tab settings

Settings Description
Number of Runs
Acquire/Analyze each test <number> times Select to repeat the test run by setting the number of times. By

default, it is selected with 1 run. The number of run feature is
available only during the live mode.

Popup Settings
Auto close Warnings and Informations during Sequencing Auto
close after <number> Seconds

Select to auto close warnings/informations during sequencing. Set
the Auto close time. By default it is unselected.

Auto close Error Messages during Sequencing. Show in Reports
Auto close after <number> Seconds

Select to auto close Error Messages during Sequencing. Set the
Auto close time. By default it is unselected.

See Also
Select report options

About setting up tests

Reports panel

Select report options
Click the Reports button and use the Reports panel controls to select which test result information to include in the report, and the naming
conventions to use for the report. For example, always give the report a unique name or select to have the same name increment each
time you run a particular test.

Select report options before running a test or when creating and saving test setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options: 

1. Select the Reports panel.
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2. Select from the report options. Refer to the following Report Options table for details.

Setting Description
Report Update Mode

Generate new report Creates a new report. The report can be in either .mht or .csv or .pdf file formats.

Append with previous run session Appends the latest test results to the end of the current test results report.
Include header in appended reports Includes header in appended reports.
Replace current test in previous run session Replaces the previous test results with the latest test results.
Report Creation Settings
Table continued…
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Setting Description
Report name Displays the name and location from which to open a DisplayPort report. The default

location is at \My TekExpress\DisplayPort\Untitled Session. The report file in this folder gets
overwritten each time you run a test unless you specify a unique name or select to auto
increment the report name.

Change the report name or location.

Do one of the following:

• In the Report Path field, type over the current folder path and name.
• Double-click in the Report Path field and then make selections from the popup

keyboard and click the Enter button.

Be sure to include the entire folder path, the file name, and the file extension. For example:
C: \Documents and Settings\your user name\My Documents\My TekExpress\DisplayPort
\DUT001.mht. This folder (C:\Documents and Settings\<user name>\MyDocuments\My
TekExpress) is mapped as X drive in the scope.

Open an existing report.

Click Browse, locate and select the report file and then click View at the bottom of the
panel.

Save as type Saves a report in the specified file type, selected from the drop-down list.

Note: If you select a file type different from the default, be sure to change the
report file name extension in the Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment the name of the report file if the application
finds a file with the same name as the one being generated. For example: DUT001,
DUT002, DUT003. This option is enabled by default.

Create report automatically at the end of the
run

Creates report at the end of the run.

Contents To Save
Include pass/fail info in details table Includes pass/fail info in the details table of the report.
Include detailed results Includes detailed results in the report.
Include plot images Includes plot images in the report.
Include setup configuration Sets the application to include hardware and software information in the summary box

at the top of the report. Information includes: the oscilloscope model and serial number,
the oscilloscope firmware version, and software versions for applications used in the
measurements.

Include complete application configuration Includes complete application configuration in the report.
Include user comments Select to include any comments about the test that you or another user added in the DUT

tab of the Setup panel. Comments appear in the Comments section, under the summary
box at the beginning of each report.

Include Informative results Include or exclude informative results in reports. This needs to be selected before you run
the tests for it to get applied.

Group Report By
Test Name Groups the tests in the report by test name.
Table continued…
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Setting Description
Test Result Groups the tests in the report by test results.
Lane Name It generates report, and all the results in the report will be grouped by lanes.
Data Rate It generates report, and all the results in the report will be grouped by data rates.
Images It includes the image below the Test Results row.
View report after generating Automatically opens the report in a Web browser when the test completes. This option is

selected by default.
View Click to view the most current report.
Generate Report Generates a new report based on the current analysis results.

Save As Specify a name for the report.
Report Type
Compliance When selected only the compliance results are selected as a part of the report.
All Results It is selected by default. When selected all normative results are displayed in the report.

See Also
View a report

About setting up tests

View a report
The application automatically generates a report when test analysis is completed and displays the report in your default Web browser
(unless you cleared the View Report After Generating check box in the Reports panel before running the test). If you cleared this check
box, or to view a different test report, do the following:

1. Click the Reports button.
2. Click the Browse button and locate and select the report file to view.
3. In the Reports panel, click View.

For information on changing the file type, file name, and other report options, see Select report options.

Report contents
A report shows detailed results and plots, as set in the Reports panel.

Setup Configuration
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Setup information is listed in the summary box at the beginning of the report. This information includes the DUT id, date/ time of the report,
device type, app version, TekExpress version, execution mode, overall compliance mode, overall test result, overall execution time DUT
automation, scope model, scope serial number, SPC factory calibration, and more.

To exclude this information from a report, clear the Include setup configuration check box in the Reports tab before running the test.
If you selected to include comments in the test report, any comments you added in the DUT tab are shown at the end of the setup
information summary.

DUT comments

If you select to include user comments in the test report, any comments you added in the DUT tab are shown at the end of the report.

Test Name Summary Table

The test name summary table indicates whether a test is passed or failed. If the test is passed, the column cell appears is green. If the test
is failed, it appears in red. If the test is skipped or has error, it appears in blue. To exclude this information from a report, clear the Include
pass/fail info in details table check box in the Reports tab before running the test. If Pattern fails and user selects Skip test if validation
fails then status of that test will be ‘Skipped’. In case the user selects ‘Reacquire’ and it fails to acquire good pattern in 10 attempts then
that pattern will be skipped from acquiring. Test status of the test which uses that pattern will be ‘Skipped’.

Details results

Includes detailed measurement information.
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To exclude this information from the report, clear the Include detailed results check box in the Reports tab.
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Running tests and viewing results

About running tests
After selecting and configuring tests, review the pre-run checklist and then click Start to perform the tests. The application acquires and
analyzes the data, then displays a report when the tests are complete.

While the tests are running, other applications may display windows in the background. The TekScope application takes precedence
over other applications, but you can switch to other applications using the Alt+Tab key combination. To keep the TekExpress DisplayPort
application on top, select Keep On Top from the DisplayPort Options menu.

Waveforms generated during the test are automatically saved when you save the related test setup, so you can run tests in pre-recorded
mode.

See Also
Before you click start

About configuring tests

About setting up tests

Before you click start
Before you run tests for the first time, do the following: 

1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress DisplayPort, it creates the following folders on the oscilloscope:

• Windows 10: C:\Program Files\Tektronix\TekExpress\ TekExpress DisplayPortTx
• \My Documents\My TekExpress\ DisplayPort
• \My Documents\My TekExpress\DisplayPort\ Untitled Session

Every time you launch TekExpress DisplayPort, an Untitled Session folder is created in the DisplayPort folder. The
Untitled Session folder is automatically deleted when you exit the DisplayPort application.

CAUTION:

Do not modify any of the session files or folders because this may result in lost data or corrupted session files. Each session
has multiple files associated with it. When you save a session, a .TekX file, and a folder named for the session and containing
the associated files, is created on the oscilloscope X: drive.

2. Map the shared My TekExpress folder as X: (X drive) on all the instruments used in test setups running Microsoft Windows Operating
System.

The My TekExpress folder has the share name format <domain><user ID>My TekExpress. Or, if the instrument is not connected
to a domain, then the share name format is <instrument name><user ID> My TekExpress. This shared folder is
used to save the waveform files and is used during other file transfer operations.

Note: If the X: drive is mapped to any other shared folder, the application will display a warning message asking you to
disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access, and that the contents are not set to be encrypted:

a. Right-click the folder and select Properties.
b. Select the General tab and then click Advanced.
c. In the Advanced Attributes dialog box, make sure that the option Encrypt contents to secure data is NOT selected.
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Example.

4. See the pre-run checklist before you run a test.

See Also
View test-related files

Application directories and usage

File name extensions

Pre-Run checklist
Do the following before you click Start to run a test. If this is the first time you are running a test on a setup, refer to the information in
Before you click start.

1. Make sure that all the required instruments are properly warmed up (approximately 20 minutes).
2. Perform the Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.
b. Select Instrument Calibration.

3. Deskew channels.
4. Make sure that the application is able to find the oscilloscope. If it cannot, perform a search for connected instruments.

a. Launch the DisplayPort application.
b. Select the Setup panel and then click the Test Selection tab.
c. Select any test and then click Configure.
d. In the Configuration section, click Global Settings.
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e. In the Instruments Detected section, click the drop-down arrow to the right of Real Time Scope and make sure that the correct
oscilloscope is listed.

See Also
Equipment connection setup

Run a test in pre-recorded mode
This option allows you to re-run a complete test using just the oscilloscope and the saved test setup files. 

Note: Running the test in pre-recorded mode does not replace the existing saved test results. Instead, if you save the test under
the same name, the results are saved in a session folder named for the date and time of the session.

1. Open the desired saved test setup.
2. In the Setup panel, select the DUT tab and then select Use pre-recorded waveform files.

A Run session field displays, showing the session that ran for this test. If there is more than one session that contains test data (not an
empty session folder) these are available in the Run session drop-down list. Select the desired session from the drop-down list.

3. Select the Acquisitions tab.
4. In the Acquisitions table, look in the Waveform FileName column.

5. If no waveform files are listed, click the ellipsis button ( ) and then locate and select the desired waveform files. Skip to step 7.
6. If waveform files are listed, verify that the listed files are the ones you want to use. If they are not, or if you want to add a file, do any of

the following as needed:

• To remove a waveform file from the list, click the ellipsis button and select Remove Waveform File.
• To replace a waveform file, click the ellipsis button, select Replace Waveform File, then locate and select the desired file.
• To add a waveform file, click the ellipses button, select Select Waveform Files, then locate and select the waveform files.

7. Click Start to run the test.

See Also
Before you click start

About acquisitions

View the progress of analysis
The Status panel displays a record of the test as it executes. By default, the application switches to this panel after you click the Start
button. Choose from the following two views by selecting the named tab, even while a test is in progress.

Test status
The Test Status tab presents a collapsible/expandable table with information about each test as it is running.

Table 13: Status tab table

Column Description

Test Name Name of the test

Table continued…

Running tests and viewing results

76



Column Description

Acquisition The type of pattern data being acquired

Acquire Status Progress state of the acquisition:

• To be started
• In progress
• Completed
• N.A.

Analysis Status Progress state of the analysis:

• To be started
• In progress
• Completed

Log view
The Log View tab provides a list of actions that happen as the test executes. Use this tab to monitor, review, or troubleshoot tests.

Table 14: Log view options

Item Description

Message History This window timestamps and displays all run messages.

Auto Scroll Select this check box to have the program automatically scroll down as information is added to the log during
test execution.

Clear Log Click this button to clear all messages in the Message History window.

Save Use to save the log file as a text file for examination. Displays a standard Save File window and saves the status
messages in the file that you specify.

See Also
View test results

View test results
When a test completes, the application switches to the Results panel, which shows a summary of test results.

Each test result occupies a row in the Results table. By default, results are displayed in summary format, with the measurement details
collapsed. You can change the view in the following ways: 

• To view the results grouped by lane, test, or data rate, select the corresponding item from the Preferences menu.
• To expand all tests listed, select View Results Details from the Preferences menu.
• To expand and collapse tests, use the plus and minus buttons to the left of the test rows.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
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• To expand the width of a column, place the cursor over the vertical line that separates the column from the one to the right. When the
cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.

• To sort the test information by column, click the column head. When sorted in ascending order, a small up arrow is displayed. When
sorted in descending order, a small down arrow is displayed.

• To clear all test results displayed, click Clear ( ).

See Also
View a report

View the progress of analysis

View a report
After the analysis, a report is automatically generated. By default, the report is displayed in your Web browser unless you cleared the View
Report After Generating check box in the Reports panel before running the test. If you cleared this check box, or you if want to view a
different test report, then do the following: 

1. In the Reports panel, click the Browse button to the right of the Report Name field and locate the desired report.

The path to the report displays in the Report Name field.
2. At the bottom of the Reports panel, click View.

For information on changing the file type, file name, and other report options, see Select report options.

Report Contents
In the report, a table shows the test name, measurement details, test result (pass/fail), mode, and analysis time.

Setup configuration information:

Setup configuration information is listed in the summary box at the beginning of the report. This information includes the oscilloscope
model and serial number, probe model and serial number, software versions, and more. To exclude this information from a report, clear the
Include Setup Configuration check box in the Reports tab before running the test. If you selected to include comments in the test report,
any comments you added in the DUT tab are shown at the end of the setup information summary.

Pass/Fail summary:

The Pass/Fail Summary column indicates whether a test passed or failed. If the test passed, the column cell is green. If the test failed, it is
red. To exclude this information from a report, clear the Include Pass/Fail Results Summary check box in the Reports tab before running
the test.

Detailed results:

Includes detailed measurement information.
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To exclude this information from the report, clear the Include Detailed Results check box in the Reports tab.

Plot images

Plot images are screen shots captured from the oscilloscope during test execution. They show waveform and measurement data.

To exclude plot images from a report, clear the Include Plot Images check box before running a test.

Application configuration

This table lists general, common, and acquired parameters used in the test. General parameters are those selected to be included in
all tests (where applicable). General parameters, are set in the DUT tab. Acquire parameters are those that were actually used for the
acquired pattern during the test. To exclude this information from a report, clear the Include Complete Application Configuration check
box before running a test.

See Also
View test results

View test-related files

View test-related files
Files related to tests are stored in the DisplayPort folder under the My TekExpress shared folder. In the DisplayPort
folder, each test setup has a test setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the

DisplayPort icon and usually has no visible file extension. For example, .

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. In the example below, the test setup folder is
Eye_PRBS-HBR2 and the DUT is DUT001:

Inside the DUT001 folder are the session folders and files. Each session has a folder and file pair, both named for the test session using
the naming convention (date)_(time). Each session file is stored outside its matching session folder.
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Each session folder contains image files of any plots generated from running the test session, and any waveform files if pre-recorded
waveform files were used during the session.

The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at ..\My
TekExpress\DisplayPort. Once you name and save the session, the Untitled Session folder name is changed to the one you
specified. 

Note: By default, test report files are saved in the session folder. You can change where the report file is saved for a specific test
session.

See Also
File name extensions

Before you click start
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DisplayPort DUT control application

Introduction to DUT control appp
This section describes the functionality and usage of Tektronix DP DUT control application.

Supported DisplayPort version
The application supports the following versions of DisplayPort application:

• DisplayPort v1.2 (upto HBR2)
• DisplayPort v1.4 (upto HBR3)

Software requirements
The software requirements are:

• Tektronix Oscilloscope with TekExpress DisplayPort Application (opt DP12)
• DPR-100 Reference sink (Unigraf)
• GRL-USB-PD (required for only Type-C connector testing)

Purpose of the application
The Tektronix DP DUT Control App is used to test:

• Standard
• Type-C connector

Equipment connection setup
Following are the connection setup diagrams for testing Type-C and Standard connectors.
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Figure 12: Connection diagram for testing Type-C connector

Figure 13: Connection diagram for testing Standard connector
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Install the software
The Tektronix DP DUT Control App and the device drivers will be installed along with TekExpress DisplayPort Tx application.

Run the application
To run the application:

1. Click the executable file DPUnigrafControllerApplication.exe.

The installer launches the application.

2. If DPR100 controller and GRL-USB-PD is connected, then the application displays the following information on top of the window:

• DPR-100 Connected to COM<n>
• ALT Mode Controller Connected

If GRL-USB-PD ALT Mode Controller is disconnected then the application displays the below information:
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Note: If you connect any devices after the application is launched, you have to re-start the Tektronix DP DUT Control App in
order to detect them.

Application features
The application displays the following tabs:

1. Phy Test: Allows you to change the DisplayPort test pattern.
2. Alt Mode: Allows you to set the DUT in ALT Mode.
3. Debug: Allows you to read and write in the specified DPCD registers.
4. AUX: Allows you to change the AUX amplitude for AUX sensitivity measurement.

DPR-100 license
The DPR-100 controller needs a license to control the DUT.

The DPR-100 is a 40-bit license, provided by Unigraf. This license varies with the DPR-100 seed number. You need to use the correct
license in order for the application to work properly.

Use one of the following two methods to specify the license:

• Enter the license in the License field.

Note: Leave a space between two hex digits.

• Update the license.txt file.

• Open the folder where the application is installed.

• Open license.txt.
• Enter the new license value in the text file.

The license is of the format a0 a9 c1 xx xx fc 01 16 3a b1 0b 1b a6 5f b6 e3 08 8c 8a xx.

Phy Test tab
This tab allows you to change the DisplayPort test pattern.
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Supported configurations are:

Field Name Configuration
Data Rate • 1.6 Gbps (RBR)

• 2.7 Gbps (HBR)
• 5.4 Gbps (HBR2)
• 81. Gbps (HBR3)

DP Version • DP Rev 1.1
• DP Rev 1.2
• DP Rev 1.4

Table continued…
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Field Name Configuration
Data Pattern • D10p2 (D10.2)

• PRBS7
• PCTPAT
• PLTPAT
• COMP-EYE

Voltage • 400 mV
• 600 mV
• 800 mV
• 1200 mV

Pre-emphasis • 0 dB
• 3.5 dB
• 6.0 dB
• 9.5 dB

SSC • Enabled
• Disabled

Is TypeC? Select, if you are testing for Type-C connector.

Note: GRL-USB-PD controller is required to test the Type-
C connector.

Script File Path Specify the script file that needs to be executed for changing the
patterns. Refer to How to change the DP DUT control scripts?

Cick Apply to execute the specified script.

When is script is completed, it displays the following dialog box.

Note: The DUT will accept the voltage swing and pre-emphasis combination as per the constraint in the table below.
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Voltage swing level
Pre-emphasis test
Level 0 Level 1 Level 2 Level 3
Vdiff_pre_pp Vdiff_pre_pp Vdiff_pre_pp Vdiff_pre_pp

0 Required Required Required Optional
1 Required Required Required Not allowed
2 Required Required Not allowed Not allowed
3 Optional Not allowed Not allowed Not allowed

Alt Mode tab
This tab allows you to set the DUT in DisplayPort Alt mode.

Complete the following steps to set the DUT:

1. Put DUT in Alt Mode: When clicked the application will configure the sink, enable the VDM, and set the DUT into DP alt mode.
2. HPD: Click to simulate the HPD.
3. Attach: Click to attach to the DUT.
4. Detach: Click to simulate the detach.

Debug tab
This tab allows you to read and write the DPCD registers. For Standard connector HPD IRQ, DeAssertHPD is issued.

DisplayPort DUT control application

TekExpress® DisplayPort Automated Solution Application Help 87



Complete the following steps to debug:

1. DPCD Address: Enter the DPCD address.
2. Read: Displays the PCD register value from the specified DPCD Address.
3. Value to write: Enter the value to write the DPCD address.

Note: The value should be in HEX.

4. HPD IRQ: Allows you to assert the HPD IRQ to the specified millisecond.
5. DeAssertHPD: Click to issue the DeAssertHPD signal.

AUX tab
This tab allows you to change the AUX amplitude for the AUX sensitivity measurement.

Complete the steps to configure the AUX:

1. AUX Amplitude (mV): Specify the required amplitude, in millivolts.
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2. Set Amplitude: Click to set the amplitude on DPR-100.
3. Scope setup and Measure: Click to set all the oscilloscope settings (Vertical and Horizontal settings), initiate the Aux transactions,

and capture the signal on the oscilloscope. When the transaction is complete, the application measures the amplitude of the signal and
reports it.

Verify Data Rate, Pattern, and SSC
Complete the following steps to verify the Data Rate, Pattern, and SSC parameters.

Note: DPOJET (Tektronix Jitter, Noise and Eye Diagram Analysis software) is required to verify the parameters.

1. Vertical Setting : Select Vertical > Vertical Setup. Adjust the scale so that the waveform occupies the eight division of the
oscilloscope.

2. Horizontal Setting : Select Horiz/Acq > Horizontal/Acquisition Setup. Select Sample Rate of 10 GS/s and Record Length of 10 M.

3. DPOJET Settings: Select Analyze > Jitter and Eye Analysis (DPOJET). Select the following measurements:

a. Jitter > RJ
b. Standard > DisplayPort > DP_SSC_Mod_Rate

DisplayPort DUT control application

TekExpress® DisplayPort Automated Solution Application Help 89



Note: Ensure that the values of Bit Rate and Pattern Length are valid.

The following table lists the Pattern Length for the available patterns:

Pattern Pattern length
D10.2 2
PRBS7 127
PLTPAT 2
COMP-EYE 2520

If SSC is enabled, then the mean SSC Mod Rate is 22 kHz.

How to change the DUT DP control scripts
The Application uses the scripts for controlling the DUT to transmit different test pattern.

// Script for controlling the DUT. This is a comment
DeAssertHPD
//Specify the delay. Delay is in mSec.
Delay 1000     
//Perform the link training. 
//Set TEST_LINK_RATE, TEST_LANE_COUNT. Specify 
FINAL_VOLTAGE_SWING,
//FINAL_PREEMPHASIS, FINAL_POST_CURSOR2     
LinkTrainingExt
Delay 1000     
// Assert HPD signal
AssertHPD
Delay 1000 
//Send HPD IRQ signal 
HPDIRQ 
//Change the pattern, voltage, pre-emphais values
//It changes the PHY_TEST_PATTERN, ADJREQ_VOLTAGE_SWING, ADJREQ_PREEMPHASIS
PhyTest
Delay 1000
HPDIRQ      

The commands can be modified as per the requirement. The available commands are:
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Command Description
AssertHPD Asserts HPD
DeAssertHPD De Asserts HPD
HPDIRQ Sends HPD IRQ signal
Delay Causes the specified amount of delay. Below command shows

1Sec delay

Delay <timeInMilliSec>

e.g: Delay 1000

DPCDReg Sets the specified DPCD register by the value specified

DPCDReg <Address in Hex>,<Value in Hex>

e.g DPCDReg 248,0

ConfigurePattern Sets the required DPCD register to change the pattern.
ConfigureSSC Sets the required DPCD register to change the SSC.
ConfigureDataRate Sets the required DPCD register to change the data rate.
ConfigureAmplituePreEmphasis Sets the required DPCD register to change the amplitude and

pre-emphasis values.
ClearAllBits Clears the bits which are set for controlling the DUT.
LinkTraining Perform the initial link training.
LinkTrainingExt Perform the 2nd link training.
PhyTest Change the pattern.
PctsPhyTestPattern Perform the initial link training (Performs the Link negotiation)
PctsLinkTraining Perform the 2nd link training (Performs the Link negotiation)
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Switch Matrix application

Product description
Switch Matrix application allows to configure and setup automated multi-lane testing using RF switch. The solution allows you to map each
of the several transmitter signals and forward the selected input either to another relay or to the oscilloscope channel.

Application overview
This section describes the Switch Matrix application settings.

Table 15: Switch Matrix configuration settings

Item Description

Click to expand/collapse the switch matrix configuration.

Options Click Help to view the software help document and About Switch
Matrix for software version.

Switch Matrix configuration
Table continued…
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Item Description

Configuration Select the configuration option:

• Keithley S46T: 6-input-to-1-output switch configuration
• Gigatronics ASCOR 8000: 8-input-to-1-output switch

configuration
• Auto Detect: Select to autodetect the switch.
• New Configuration: Select to manually configure the switch.
• Saved file names: Saved configuration file name(s) are

displayed in the drop-down list. Select to recall the
configuration.

• Show All Files : Select to view the list of all saved files.

Vendor
Select the vendor from the drop-down list. This field is displayed:

• When you select Configuration > New Configuration to create
afresh configuration.

• When you open a saved configuration. The displayed vendor
name is not editable.

• When Auto Detect is selected. The displayed vendor name is
not editable.

Link Width
Select the Link Width from the drop-down list. This determines the
maximum number of lanes supported by the DUT.

Add <X> more lane(s)
Select to add extra lanes (Additional1, Additional2,....) to the lanes
list. The extra lanes added are displayed in the relay signals.

You can add a maximum of 10 lanes.

Table continued…
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Item Description

Rename Lanes
Click to rename the lanes. Enter the LanePrefix and select the
increment label type to suffix by either number or alphabet. The
number of lanes depends on the Link Width selected. Clear the
Auto rename lane check box to set unique names for the lanes.

De-embed

De-embed 1
Select the De-embed option:

• None
• All relays (Recommended)
• Each relay type separately (SP4T, SP6T, etc.)
• Each relay separately
• Each connection

Select the de-embed option and click Select Filter File to browse
and select the filter file(s).

Debug Mode
Table continued…

1 Configure at least one relay before configuring the de-embed settings.
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Item Description

Debug Mode
Select Debug Mode to manually configure the switch.

Switch Address

Enter the Switch Address in the GPIB or TCPIP format.

GPIB format: GPIB0:X:INSTR
TCPIP format: TCPIP::IPADDR::INSTR
Init Switch

This will synchronize the configuration of relay(s) in the application
with the relay(s) in the switch. Synchronization will be successful
only for the relays whose configuration matches with the physical
switch. Pass/Fail status is displayed next to the button.

Note: Relay configurations (number of relays, number of
relay inputs, and name of relays) in the application should
match the physical switch, for successful synchronization.

Switch Self-Test

This will close and open all switch channels one-by-one and
displays the pass/fail status of the channel next to the ID. A self-test
report (CSV) is generated at the end of the process. You cannot
abort this process.

Note: Initialize the switch before performing the self-test.

Reset Switch

Click Reset Switch to reset the switch. This will open all channels.

Scope Address

Enter the oscilloscope address in the GPIB or TCPIP format.

GPIB format: GPIB0:X:INSTR
TCPIP format: TCPIP::IPADDR::INSTR
Init Scope

Enter the oscilloscope address in the Scope Address field and
click Init Scope to initialize the oscilloscope. This will establish the
connection with the oscilloscope. The pass/fail status is displayed
next to the button.

Apply De-embed settings

Select to apply de-embed settings to the channels.

When the oscilloscope is initialized and de-embed settings are
configured, closing a connection will apply the de-embed settings
and then close the connection.

Relays
Table continued…
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Item Description

Relays
Select the relay(s). In SPnT, n represents the number of connection
signals for the relay. For example, SP4T is a four signal connection
relay.

This field displays only for a new configuration. By default, zero
relays are selected.

Enter the total number of relays to be loaded in their respective
input box and click Load.

You can also click  or  to increase or decrease the number.

Save Click to save the configuration at C:\ProgramData\Tektronix\Switch
Matrix Configurations\*.xml.

This operation checks whether all the required configurations are
done. If any of the required configurations are not selected, then
error popup is displayed, which prompts you to complete the
configuration(s).

Clear All Click to clear all configurations. The application will be loaded with
Configuration drop-down (default).

Channel Status Click to view the relays and status of channels of Keithley or
Gigatronics switch. This updates the channel status dynamically.

In Switch Channel Status Viewer, select the Vendor type, enter
the Switch Address and click Init to initialize the switch. This will
establish the connection with the switch.

Click Query Status to get the details of the relays of the switch and
the status of the channels.

Click Reset to reset the status viewer.

Table continued…
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Item Description

Graphical View
Click to view the graphical representation of the configured relays.
If the relays are cascaded, then they are also displayed in the
graphical representation.

Relay configuration

Signal Polarity
Select the signal polarity of DUT:

• Positive: populates Lane0+, Lane1+, …. connection signals.
• Negative: populates Lane0-, Lane1-, …. connection signals.
• Differential: populates Lane0, Lane1, …. connection signals.

Relay Name
Enter the relay name. This name should match the relay name of
the connected switch.

Delete Click to delete the relay. This configuration is only available for the
configured (loaded) relays, when Configuration > New Configuration
is selected.

Cascade
Select to cascade the relay by connecting the common channel as
the input signal for another relay.

Select the Relay and the Input of the relay. Check that the selected
relay signal displays the appropriate relay name.

The cascade settings is also displayed in the graphical view.

Click here to get details about Cascade.

Note: Select the cascade settings before you save the
configuration.

Common
Select the oscilloscope channel for Common. If cascaded, it
displays the name of the relay.

Click Reset Inputs to clear all connection signal settings.

Note: Select the common settings for all the relays, before
you save the configuration.

Table continued…
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Item Description

Signal

Select the DUT connection signal. This drop-down list shows the
lanes based on Link Width and Signal Polarity settings.

If the link width is x8 and signal polarity is Positive, then the Signal
drop-down list will have Lane0+ to Lane7+ options.

Input

This button is enabled only in debug mode and if a valid signal is
configured for the channel. Click to close or open the channel.

ID

Enter the three character alias name for the channel. This is shown
in the graphical view of switch matrix configuration.

Filter File

This column shows  or  indicating the status of the filter
file configuration for the channel. If no de-embed option is selected,
then this column remains blank.

Status

This column displays the status of the channel.

Channel closed (normally closed) : 

Channel opened (normally opened) : 

File name extensions
This application uses the following file name extensions:

File name extension Description
.html Saved configuration and Graphical view file formats
.xml Switch Matrix configuration files

Status indicators

Status indicators Description

Success indicator

Table continued…
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Status indicators Description

Failure indicator

Closed channel indicator (NC = Normally Closed)

Opened channel indicator (NO = Normally Opened)

Saved configurations
Click Configuration > Show All Files to view the list of all saved files.

Table 16: Saved configurations

Item Description
Open Opens the selected file.
Delete Deletes the selected file.
Cancel Closes the Saved Configurations window.

De-embed settings
De-embed allows you to apply filter file(s) for relay(s). Select the De-embed option and click Select Filter File to browse and select the
filter file(s).
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Figure 14: De-embed options

Apply a filter file for all relays
Select to apply a single filter file for all relays. 

Click  to browse and select the filter file for the switch. To apply the filter file for the fixture, select Choose filter file for fixture and
browse the filter file.

Apply a filter file for each relay type separately
Select to separately apply a single filter file for each relay type. 
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Select the Relay type from the drop-down list; click  to browse and select the filter file for the switch. To apply the filter file for the
fixture, select Choose filter file for fixture and browse the filter file.

Tip: Click  or  to select the previous or next relay type.

Tip: The selected relay types are highlighted in dark blue in the application.
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Apply a filter file for each relay separately
Select to separately apply a filter file for each relay. 

Select the Relay from the drop-down list; click  to browse and select the filter file for the switch. To apply the filter file for the fixture,
select Choose filter file for fixture and browse the filter file.

Tip: Click  or  to select the previous or next relay.

Tip: The selected relay is highlighted in dark blue in the application.

Apply a filter file for each connection separately
Select to apply a filter file for each connection. 

Select the Relay and the Input from the drop-down list; click  to browse and select the filter file for the switch. To apply the filter file for
the fixture, select Choose filter file for fixture and browse the filter file. Select Choose different filter file for cable to browse and select the
filter file for cable.
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Tip: Click  or  to select the previous or next channel.

Tip: The selected relay signal is highlighted in dark blue in the application.

Note: Clicking  on the last input of a relay selects the first input of the next relay; clicking  on the first input of
a relay selects the last input of the previous relay.

Graphical view of switch matrix configuration
The Graphical view displays the pictorial representation of the switch configuration. 

The following figure displays the graphical view of a Keithley switch configuration.

Saving the configuration
Click Save in the configuration panel; in the Configuration Save dialog box, enter the file name and click Save. The default save path is
C:\ProgramData\Tektronix\Switch Matrix Configurations\. 

Note: Save configuration checks whether all the required configurations are done. If any of the required configurations are not
selected, then error message is displayed, which prompts you to complete the configuration(s).
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Feature description

Link width
Link width determines the number of DUT signals. For example, x8 represents an eight lane DUT. 

This works in conjunction with the signal polarity selected for each relay. For example, if the link width is x8, and:

• If the signal polarity is Positive, then the signal drop-down list will have selections from Lane0+ to Lane7+.
• If the signal polarity is Negative, then the signal drop-down list will have selections from Lane0- to Lane7-.
• If the signal polarity is Differential, then the signal drop-down list will have selections from Lane0 to Lane7.

Debug mode

Init Switch
Enter the switch address and click Init Switch to initialize the switch. This will synchronize the configuration of relay(s) in the application
with the relay(s) in the switch. Synchronization will only be successful for those relays that match the physical switch. The pass/fail status
is displayed next to the button.

The factory default GPIB address for Keithley (GPIB0::7::INSTR) and Gigatronics (GPIB0::4::INSTR) is populated in the switch address
based on the configured vendor. You can enter the address in GPIB (GPIB0:X:INSTR) or TCPIP (TCPIP::IPADDR::INSTR) format.

Note: Relay configurations (number of relays, number of relay inputs, and name of relays) in the application should match the
physical switch, for successful synchronization.

Switch Self-Test
This will close and open all switch channels one-by-one. A selftest report (CSV) is generated at the end of the process. You cannot abort
this process.

Note: Initialize the switch before performing the Switch Self-Test.

Reset Switch
Click Reset Switch to reset the switch. This will open all channels.

Init Scope
Enter the oscilloscope address in the Scope Address field and click Init Scope to initialize the oscilloscope. This will establish the
connection with the oscilloscope. The pass/fail status is displayed next to the button. 

You can enter the address in GPIB (GPIB0:X:INSTR) or TCPIP (TCPIP::IPADDR::INSTR) format.

When the oscilloscope is initialized and de-embed settings are configured, closing a connection will apply the de-embed settings and then
close the connection.

Note: The virtual GPIB address of the oscilloscope is GPIB8::1::INSTR.

Note: If oscilloscope fails to respond to the *IDN? query during initialization, then the connection attempt is considered a failure.
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Cascade (Relay cascade)
This feature allows you to cascade the relay by connecting the common channel as an input signal for another relay. 

To cascade, select Cascade in the relay and select the Relay and Input of the relay. Check that the selected relay signal displays the relay
name, specifying that the lane input signal is the output from that relay.

Figure 15: Graphical view of relay cascade configuration
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Tip: Switch Matrix application supports only single-level cascading of the relays. For example, if the Relay A output is cascaded to
Relay B, then the Relay B output cannot be cascaded.
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Error messages

Error message Possible solution

"A filename cannot be empty and it cannot contain any of the
following characters:\n\t. .. \\ / : ? \" < > | * ! @ # $ % ^ & * ( ) - + ., /
\\ \' < >

Also, the file name cannot be \"Keithley S46T\",\"Gigatronics
ASCOR 8000\",\"Select\", \"New Configuration\", \"Custom\" , \"Auto
Detect\" or \"Show All Files\""

Configure appropriate signals before the de-embed settings. Select at least one signal for a relay before configuring the de-
embed settings.

Either the instrument address is invalid or instrument is not
connected.

Check the GPIB connection from oscilloscope to switch and verify
the instrument address.

Error occurred while trying to recall the configuration settings.

Try re-creating configuration or recalling a different configuration
file.

Re-create the configuration file or recall a different configuration file.

Error occurred while trying to access the connection for open/close
operation.

Filter file <FilterFileName> not found. Reselect the de-embed filter file and try again.

Graphical view is not generated or does not exist.

Initialize the switch Initialize the switch and then perform the switch operations.

Instrument address doesn't belong to any supported switch. Verify the switch address.

Instrument address is empty. Instrument address cannot be empty. Enter a valid
instrument address in the GPIB (GPIB0:X:INSTR) or TCPIP
(TCPIP::IPADDR::INSTR) format.

No switch detected. Connect a Keithley or Gigatronics switch and
try auto detection by selecting Configuration > Auto Detect.

Check the GPIB connection from the oscilloscope to switch and
whether the instrument is detected in TekVisa.

Number of relays cannot be more than 26

Please ensure that the name(s) of the configured relay(s) match the
ones present on the physical switch.

Relay name cannot be empty

Scope initialization failed. Check if the address is valid and ensure
that the instrument is switched on and try again.

Validate the oscilloscope address try again.

Table continued…
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Error message Possible solution

Switch communication failed... Ensure that the switch is on. Reset the switch and try again.

Switch initialization failed. Check if the address is valid and ensure
that the instrument is switched on and try again.

Validate the switch address and ensure that the instrument is
switched on. Try again.

The start count cannot be more than 74

Timeout Error. Either the command is invalid or instrument is not
active.

Check the command syntax and the connection of the instrument by
SWITCH:*IDN command.

Two or more lanes have same name. The lane names should be
unique.

Two or more relays have same name.
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Algorithms

About algorithms
This section describes the measurement algorithms used in the TekExpress DisplayPort application.

Oscilloscope setup guidelines
Before performing any measurements, perform the following steps to ensure accurate measurement results:

• Allow at least 20 minutes warm-up time for oscilloscope.
• Run the oscilloscope SPC calibration routine. Remove all probes from the oscilloscope before running SPC.
• If using probes, perform the probe calibration defined for the specific probes being used.
• Perform deskew to compensate for skew between measurement channels.

Measurement details
Measurement name Description
Eye diagram (Normative) This test evaluates the timing and amplitude support the overall

DisplayPort system objective of Bit Error Rate in data transmission.
Eye diagram is plotted to evaluate the timing and amplitude
parameters.

Non Pre-Emphasis Level Verification Testing (Normative) This test is performed to ensure that the system budget is fallowed
and ensures that the level settings are monotonic in nature.
Monotonicity helps the Sink can rely on the Source to incrementally
increase upon by the sink.

Pre-Emphasis Level Verification and Maximum Pk-Pk Differential
voltage setting (Normative)

This test measures the pre-emphasis of the Source waveform.
This is done by measuring the peak to peak differential amplitude.
Comparisons are made for the Level 0 transition state as well
as non-transition levels. Maximum peak to peak amplitude is also
measured.

HBR2/HB3 level equalization testing (Normative) This test ensures that the system budget is obeyed and ensures
that level and pre-emphasis settings are monotonic so that a Sink
can rely on the Source to incrementally increase upon request by
sink.

Inter-Pair Skew Test (Informative) This test measures the skew/time delay between the differential
data lanes.

Intra-Pair Skew Test (Informative) This test measure the skew/time delay between respective sides of
a differential data lane.

AC Common Mode Noise (Informative) This test evaluates the AC Common mode noise (unfiltered RMS) of
the differential data line.

Non ISI Jitter Measurements (Normative) This test evaluates the amount of Non-ISI jitter accompanying the
data transmission.

Total Jitter and Random Jitter(RJ/DJ) Measurement (Normative) This test evaluates the total jitter at 10-9. This can be measured
explicitly at this rate or through an approved estimation technique.

Table continued…
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Measurement name Description
Main Link Frequency Compliance (Normative) This test ensures that the average data rate under all conditions

does not exceed minimum or maximum as set by the standard.
Spread Spectrum Modulation Frequency (Normative) This test evaluates the frequency of the SSC modulation.
Spread Spectrum Modulation (Normative) This test evaluates the range of the SSC down-spreading of the

transmitter signal.
dF/dt Spread Spectrum Deviation HF Variation (Informative) This test verifies whethr the SSC profile does not include any

frequency deviation which would exceed 1250ppm/uSec.
Dual Mode TMDS Clock (Normative if supported) This test finds the duty cycle of the TMDS clock waveform of a

source operating in Dual Mode.
Dual-mode EYE diagram (Normative if supported) This test performs the eye diagram measurement and find the

timing variables and amplitude trajectories for a dual mode source
device.

See Also
Before You Click Start

Eye diagram testing (Normative)
This test evaluates the waveform, ensuring that the amplitude trajectories and timing variations of the waveform support the overall DP
system objectives of Bit Error Rate in Data transmission.

Measurement details
This measurement is performed for the below test conditions:

Data Rate RBR (Normative) HBR (Normative) HBR (Informative) HBR2 (Normative) HBR3 (Normative)

Test Point TP2 TP2 TP3_EQ TP3_EQ TP3_EQ

Pattern PRBS7 PRBS7 PRBS7 CP2520 TPS4

Voltage Swing Level 2 Level 2 Level 2 Any passing Any passing

Pre-Emphasis Level 0 Level 0 Level 0 Any passing Any passing

SSC SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

Note: If SSC is
both, then test
with SSC
Enabled only.

Lanes to be tested All lanes supported All lanes supported All lanes supported All lanes supported All lanes supported

• To get TP3_EQ, waveform is captured at TP2 and Cable emulator applied in SW.
• The eye diagram test should pass both ‘worst case cable’ and a ‘zero length cable’ model.
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Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Capture 1M Unit Intervals.
• Use the below clock recovery:

Data Rate RBR HBR HBR2 HBR3

PLL Type 2nd Order 2nd Order 2nd Order 2nd Order
Bandwidth 5.4 MHz 10 MHz 10 MHz 15 M
Damping 1.51 1.51 1.0 1.0

• To achieve the worst case cable model (wherever applicable), capture the signal at TP2 and apply the worst case cable emulator using
the MATH subsystem in the oscilloscope.

• To achieve the ‘zero length cable’, capture the signal at TP2 and do not embed any cable model.
• For HBR and HBR2 data rate needs Equalization. For each of the acquisitions above, the Analyzer applies a CTLE (Continuous Time

Linear Equalization) Transfer Function as defined in VESA specification.
• For HBR3 Data rate needs Equalization. For each of the acquisitions above, the Analyzer applies the 10 CTLE (Continuous Time

Linear Equalization) Transfer Function and creates set of waveform and clock information for each of the CTLE waveforms. The CTLE
waveform is then passed to the VESA DFE tool which provides the optimal CTLE and DFE tap value as defined in VESA specification.
The VESA DFE tool needs to be installed separately and is not part of the Tektronix DisplayPort installer.

• Plot the Eye Diagram. The rendered Eye shall have no signal trajectories entering the mask area as defined in VESA specification.
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Non Pre-Emphasis level verification testing (Normative)
This measurement ensures that the system budget is fallowed and the level settings are monotonic in nature. Monotonicity helps the Sink
can rely on the Source to incrementally increase upon by the sink.

Measurement details
This measurement is performed in the following test conditions:

Data Rate RBR (Normative) HBR (Normative) HBR2 (Informative)

Test Point TP2 TP2 TP2

Pattern PRBS7 PRBS7 PLTPAT

Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing

Pre-Emphasis Level0 Level0 Level0

SSC SSC Enabled, SSC Disabled SSC Enabled, SSC Disabled SSC Enabled, SSC Disabled

Lanes to be tested All lanes supported All lanes supported All lanes supported

HBR2 and HBR3 - PLTPAT (PreEmphais Level Test Pattern) is an 80Bit custom pattern.

1111100000 1111100000 1111100000 1111100000

1111100000 1111100000 1111100000 1111100000

Measurement
• This measurement is a ratio between two voltage peak readings each taken at a different nominal level settings with 0dB pre-emphasis

setting.
• For each of the voltage peak to peak measurement do the following:

• Perform the vertical settings such that the waveform occupies 8 divisions.
• Do the horizontal settings such that oscilloscope can capture more than 1000 qualifying patterns.

VoltagePeak_Peak = VH_NPattern – VL_Pattern , where

VH_NPattern : is the average of High differential voltage of the qualifying pattern.

VL_Pattern : is the average of Low differential voltage of the qualifying pattern.
• Qualifying pattern for RBR and HBR

1-0-1-0-1-1-1-1-1-1-1 for the VH measurement

1-0-1-0-0-0-0-1 for the VL measurement

VH is the average of the High or ‘one’ voltage over three UI ending at the 50% point of the 6th bit of the seven successive
transmitted ones of the pattern.

VL is the average of the Low or ‘zero’ voltage over two UI ending at the 50% point of the 4th bit of the four successive transmitted
0’s of the pattern.

• Qualifying pattern for HBR2

1-1-1-1-1-0-0-0-0-0 repeating for the VH and VL measurement
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VH is the average of the High or ‘one’ voltage over three UI ending at the 50% point of the 5th bit of the five successive transmitted
ones of the pattern.

VL is the average of the Low or ‘zero’ voltage over two UI ending at the 50% point of the 5th bit of the five successive transmitted
0’s of the pattern.

• For each level setting tested use the below equation.

Result = 20 * Log10[VoltagePeak-Peak_Level A / VoltagePeak-Peak_Level B]

Measurement RBR and HBR HBR2 HBR3

Veak-
Peak_Level A

Veak-
Peak_Level B

Veak-
Peak_Level A

Veak-
Peak_Level B

Veak-Peak_Level A Veak-Peak_Level B

1 Level1 Level0 Level2 Level0 Level2 Level0
2 Level2 Level1 Level2 Level1 Level2 Level1
3 Level3 Level2 Level3 Level2 Level3 Level2

• Measurement 3 is optional (test it if the device supports it)
• All the measurements are done at Nominal PreEmphasis level of 0dB

• Compare the result with the limits specified in the VESA specification.

Pre-Emphasis level verification testing and Maximum peak-to-peak differential
voltage testing (Normative)
This test evaluates the pre-emphasis of the source waveform. This is done by measuring the peak to peak differential amplitude.
Comparisons are made for the Level 0 transition state as well as non-transition levels. Maximum peak-to-peak amplitude is also measured. 

Measurement details
This measurement is performed in the following test conditions:

Data Rate RBR (Normative) HBR (Normative) HBR2 (Informative) HBR3 (Informative)

Test Point TP2 TP2 TP2 TP2

Pattern PRBS7 PRBS7 PLTPAT PLTPAT

Voltage Swing All Nominal Voltage
Swing

All Nominal Voltage
Swing

All Nominal Voltage
Swing

All Nominal Voltage Swing

Pre-Emphasis All pre-emphasis levels All pre-emphasis levels All pre-emphasis levels All pre-emphasis levels

SSC SSC Enabled, SSC
Disabled

SSC Enabled, SSC
Disabled

SSC Enabled, SSC
Disabled

SSC Enabled, SSC Disabled

Note: If SSC is both,
then test with SSC
Enabled only.

Lanes to be tested All lanes supported All lanes supported All lanes supported All lanes supported

• HBR2 - PLTPAT (PreEmphais Level Test Pattern) is an 80-bit custom pattern.
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1111100000 1111100000 1111100000 1111100000

1111100000 1111100000 1111100000 1111100000
• Constraint for Pre-Emphasis level values

Voltage swing level Vdiff_pre_pp support, by Pre-emphasis Level
0 1 2 3

0 Shall be supported Shall be supported Shall be supported May be supported
1 Shall be supported Shall be supported Shall be supported Not allowed
2 Shall be supported Shall be supported Not allowed Not allowed
3 May be supported Not allowed Not allowed Not allowed

Calculate

• Perform the vertical settings such that the waveform occupies eight divisions.
• Do the horizontal settings such that the oscilloscope can capture more than 1000 qualifying patterns.
• Transition and non-transition voltage swings are measured for each supported level and pre-emphasis setting. Each transition and

non-transition swing is composed of High and Low voltage measurements which are combined to obtain the peak-to-peak voltage.
Non-Transition voltage measurement is performed as per Non Pre-Emphasis Level Verification Testing.

• For a given voltage level and pre-emphasis level, below are the peak-to-peak voltage definitions.

VT_LvlX_PP = VT_LvlX_H –VT_LvlX_L

VN_LvlX_PP = VN_LvlX_H –VN_X_LvlX_ _L, where

• VT_LvlX_PP: Peak to peak voltage at the transition bit.
• VN_LvlX_PP: Peak to peak voltage at the non-transition bit.
• VT_LvlX_H ,VT_LvlX_L ,VN_LvlX_H , and VN_LvlX_L are identified in the following two figures showing generalized pre-emphasis

and non-pre-emphasized waveforms.
• For RBR and HBR

Figure 16: High voltage measurement
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Figure 17: Low voltage measurement

• Qualifying pattern for RBR and HBR

0-1-0-1-1-1-1-1-1-1 for ‘High’ level measurement

1-0-1-0-0-0-0-1 for ‘Low’ Level measurement

For a transition to high measurement, the precondition bits are 0-1-0. For a transition to ‘Low’ measurement, the precondition
bits are 1-0-1.

The transition voltage measurements, VT_LvlX_H and VT_LvlX_L, shall be the average value over the 40% to 70% UI points in
the transition bit.

• For HBR2 and HBR3

• Qualifying pattern for HBR2 and HBR3

1-1-1-1-1-0-0-0-0-0 for ‘High’ and ‘Low’ level measurement.

The transition voltage measurements, VT_LvlX_H and VT_LvlX_L, , shall be the average value over the 40% to 70% UI points
in the transition bit.

• For N patterns, transition measurements will average 0.3*N UI of sampled data.
• There are 3 different sets of measurements are done. All the results are Normative

• Pre-emphasis values for Level 0:
• Pre-emphasis Delta values for:

• Level 1 vs. Level 0 Pre-emphasis settings
• Level 2 vs. Level 1 Pre-emphasis settings
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• Level 3 vs. Level 2 Pre-emphasis settings
• Non transition voltage range:

• Level 2 Pre-emphasis setting
• Level 1 Pre-emphasis setting
• Level 0 Pre-emphasis setting

• Calculation

• Pre-emphasis values for Level 0

Result = 20*Log [VT_Lvl0_PP / VN_Lvl0_PP] for all supported levels
• Pre-emphasis Delta values for:

Level 1 vs. Level 0 (for Voltage swing Level 0,1 and 2) Result = 20*Log [VT_Lvl1_PP / VN_Lvl1_PP]- 20*Log [VT_Lvl0_PP /
VN_Lvl0_PP]

Level 2 vs. Level 1 (for Voltage swing Level 0 and 1) Result = 20*Log [VT_Lvl2_PP / VN_Lvl2_PP]- 20*Log [VT_Lvl1_PP /
VN_Lvl1_PP]

Level 3 vs. Level 2 (for Voltage swing Level 0, if supported) Result = 20*Log [VT_Lvl3_PP / VN_Lvl3_PP]- 20*Log [VT_Lvl2_PP /
VN_Lvl2_PP]

• Non transition voltage range:

Result = MIN(VN_LvlX_PP )/ (VN_Lvl0_PP) at each supported level for all supported X. (Level 1, Level 2, and Level 3).
• Compare the result with the limits specified in the VESA specification.

HBR2/HBR3 Level and Equalization Verification Testing (Normative)
This test evaluates the pre-emphasis of the source waveform by measuring the first and fifth harmonics for different settings of the signal.
Calculations are based on ratio of first and fifth harmonic combinations.

Measurement details
This measurement is performed in the following test conditions:

Data Rate HBR2 (Normative) HBR3 (Normative)
Test Point TP2 TP2
Pattern PLTPAT PLTPAT
Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing
Pre-emphasis All pre-emphasis levels All pre-emphasis levels
SSC SSC Disabled SSC Disabled
Lanes to be tested All lanes supported All lanes supported

• HBR2 - PLTPAT (PreEmphais Level Test Pattern) is an 80-bit custom pattern.

1111100000 1111100000 1111100000 1111100000

1111100000 1111100000 1111100000 1111100000
• Constraint for Pre-Emphasis level values
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Voltage Swing level Vdiff_pre_pp support, by Pre-emphasis level
0 1 2 3

0 Will be supported Will be supported Will be supported May be supported
1 Will be supported Will be supported Will be supported Not allowed
2 Will be supported Will be supported Not allowed Not allowed
3 May be supported Not allowed Not allowed Not allowed

Measurement
• Perform the vertical settings such that the waveform occupies eight divisions.
• Capture waveforms at different settings of scope as specified in above table
• Measure peaks at first and fifth harmonic of signal from FFT
• Calculate:

• VTX_OUTPUT_LEVEL0_RATIO = VSL[N]/VSL[0]
• VTX_OUTPUT_RATIO = VSL[N]/VSL[N-1]
• VTX_MEQ_LEVEL0_DELTA = TX_EQL[N]/TX_EQL[0]
• MinPE = ( (TX_MEQ – X1) (Y2 – Y1) / (X2 – X1) ) + Y1, where (X1, Y1) and (X2, Y2) are adjacent TX_MEQ and Normative minPE

values"
• VTX_TRANSITION_BIT_OUTPUT_RATIO = f5[N] – f5[N – 1],
• VTX_DIFFp-p_MAX

Inter-Pair skew testing (Informative)
This measurement finds the skew, or time delay between the differential data lanes.

Measurement details
This measurement is performed in the following conditions: algorithm runs as follows:

Data rate Highest bit rate supported

Test Point TP2
Pattern PRBS7 or DUT dependent custom pattern
Voltage Swing Level 2
Pre-Emphasis 0 dB
SSC SSC Enabled

SSC Disabled

Note: If SSC is both, then test with SSC Enabled only.

Lanes to be tested Source with 2 or 4 lane operation only

Measurement
• Perform the De-skew of the measurement channel.
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• Perform the vertical settings such that the waveform occupies 8 divisions.
• Do the horizontal settings such that oscilloscope can capture more than 100 qualifying edges.
• Capture the waveform on at least 2 channels simultaneously.
• Find the common point on the waveform and use this common point for evaluation of the skew.

At this common point find the time difference between the corresponding edges at the transition point (use transition voltage as 0Volts).
• According the DisplayPort specification, 20UI offset is allowed Lane 0 to Lane 1, Lane 1 to Lane 2, and from Lane 2 to Lane 3. The

result is cumulative, between Lane 0 and Lane 2, the offset will be 40UI.
• Skew is calculated as

Inter-Lane Skew Tolerance = {1/NumEdges}Σ | TTransition_LaneA - TTransition_LaneB | - Nominal Skew, where

Nominal Skew: Expected offset between the tested lanes.
• Calculate the below skew values.

Two lane operation Lane 0 to Lane 1

Four lane operation Lane 0 to Lane 1

Lane 0 to Lane 2

Lane 0 to Lane 3

Lane 1 to Lane 2

Lane 1 to Lane 3

Lane 2 to Lane 3

• Compare the result with the limits specified in the VESA specification.

Intra-Pair skew test (Informative)
This measurement calculates the skew or time delay between respective sides of a differential data lane. 

Measurement details
This measurement is performed in the following test conditions:

Data rate Highest bit rate supported

Test Point TP2

Pattern D10.2

Voltage Swing Level 2

Pre-Emphasis 0 dB

SSC SSC Enabled

SSC Disabled

Note: If SSC is both, then test with SSC Enabled only.

Table continued…
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Lanes to be tested All lanes supported

Measurement algorithm
• Perform the De-skew of the measurement channel.
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Do the horizontal settings such that oscilloscope can capture more than 100 qualifying edges.
• Capture the Positive and negative channels simultaneously using 2 channels of oscilloscope using 2 single ended probes.
• The rising edge of the data true signal (D+) is compared with the complement’s (D-) falling edges, and the rising edge of the

complement is compared to falling edge of the data true signal.

Find the time of transition by determining when the waveform crosses the transition amplitude.
• Find VH and VL for single-ended signals D+ and D by finding the average value over the .6 to .75 UI region past the edge.

For D+: measure VH+ . VL+

For D-: VH- ,VL-

VTransition_Data+= {VH+ + VL+ } / 2

VTransition_Data-= {VH- + VL- } / 2

Skew = {1/NumEdges}Σ [ ( D+Transition_High - D-Transition_Low ) + ( D+Transition_Low - D-Transition_High ) ]/2
• Compare the result with the limits specified in the VESA specification.

AC common mode noise (Informative)
This measurement evaluates the AC common mode noise (unfiltered RMS) of the differential data line.

Measurement details
This measurement is performed in the following test conditions:

Data rate All supported bit rates

Test Point TP2

Pattern PRBS7

CP2520 pattern3(TPS4) for HBR3

Voltage Swing All Nominal Voltage Swing

Pre-Emphasis All Pre-Emphasis levels

SSC SSC Enabled

SSC Disabled

Note: If SSC is both, then test with SSC Enabled only.

Lanes to be tested All lanes supported
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Measurement
• Perform the De-skew of the measurement channel.
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Do the horizontal settings such that oscilloscope can capture more than 100,000 edges.
• Capture the Positive and negative channels simultaneously using 2 channels of oscilloscope using 2 single ended probes.
• Calculate the measurement as below.

VTX-AC-CM = (VTX-Plus + VTX-Minus)/2
• Compare the result with the limits specified in the VESA specification.

Non-ISI jitter measurements (Normative)
This measurement evaluates the amount of Non-ISI jitter accompanying the data transmission.

Measurement details
This measurement is performed in the following test conditions:

Data rate RBR HBR HBR2 HBR3

Test Point TP2 TP2 TP2 TP2

Pattern PRBS7 PRBS7 COMP-EYE CP2520 pattern3(TPS4)

Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing All Nominal Voltage Swing

Pre-Emphasis Level 0 (0 dB) Level 0 (0 dB) Level 0 (0 dB) Level 0 (0 dB)

SSC SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

Note: If SSC is
both, then test with
SSC Enabled only.

SSC Enabled

SSC Disabled

Note: If SSC is
both, then test with
SSC Enabled only.

SSC Enabled

SSC Disabled

Note: If SSC is
both, then test with
SSC Enabled only.

Lanes to be tested All lanes supported All lanes supported All lanes supported All lanes supported

The test may or may not pass at other Pre-Emphasis levels.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Capture 1M Unit Intervals.
• Use the below clock recovery.

Data rate RBR HBR HBR3

PLL Type 2nd Order 2nd Order 2nd Order
Bandwidth 5.4 MHz 10 MHz 15 MHz
Damping 1.51 1.51 1
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• Perform the TJ (Total Jitter) measurement using Dual Dirac technique. TJ is estimated as

TJ = DJdd + n * RJ, Where

• DJ: Deterministic jitter
• RJ: Random jitter
• n: 12 for RBR/HBR/HBR2 and n: 9.5 for HBR3 ( to accommodate a Bit Error Ratio value of 1*10-9)

• Calculate Non-ISI jitter as

JitterNON_ISI = TJ – JitterISI , where

JitterISI : is data dependent jitter due to ISI.
• Compare the result with the limits specified in the VESA specification.

Total jitter (TJ) and RJ (RJ/TJ) measurement (Normative)
This test evaluates the total jitter at 10-9. This can be measured explicitly at this rate or through an approved estimation technique.

Measurement details
This measurement is performed in the following test conditions:

Data rate RBR
(Normative)

HBR (Normative) HBR (Informative) HBR2 (Normative) HBR3 (Normative)

Test Point TP2 TP2 TP3_EQ TP3_EQ TP3_EQ

Pattern PRBS7 PRBS7 PRBS7 CP2520 TS4

Voltage Swing All nominal
levels

All nominal levels All nominal levels Any passing Eye setting Any passing Eye setting

Pre-Emphasis Level 0 Level 0 Level 0 All nominal levels All nominal levels

SSC SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

SSC Enabled

SSC Disabled

Note: If SSC is
both, then test
with SSC
Enabled only.

Lanes to be
tested

All lanes
supported

All lanes supported All lanes supported All lanes supported All lanes supported

• To get TP3_EQ, waveform is captured at TP2 and Cable emulator applied in SW.
• The eye diagram test should pass both ‘worst case cable’ and a ‘zero length cable’ model.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Capture 1M Unit Intervals.
• Use the following clock recovery values:
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Data rate RBR HBR HBR2 HBR3

PLL Type 2nd Order 2nd Order 2nd Order 2nd Order
Bandwidth 5.4 MHz 10 MHz 10 MHz 15 MHz
Damping 1.51 1.51 1.0 1.0

• To achieve the worst case cable model (Where ever applicable, for the selected data rate), capture the signal at TP2 and apply the
worst case cable emulator using the MATH subsystem in the oscilloscope.

• To achieve the ‘zero length cable’, capture the signal at TP2 and do not embed any cable model.
• For HBR and HBR2 data rate needs Equalization. For each of the acquisitions above, the Analyzer applies a CTLE (Continuous Time

Linear Equalization) Transfer Function as defined in VESA specification.
• For HBR3 Data rate needs Equalization. For each of the acquisitions above, the Analyzer applies the 10 CTLE (Continuous Time

Linear Equalization) Transfer Function and creates set of waveform and clock information for each of the CTLE waveforms. The CTLE
waveform is then passed to the VESA DFE tool which provides the optimal CTLE and DFE tap value as defined in VESA specification.
The VESA DFE tool needs to be installed separately and is not part of the Tektronix DisplayPort installer.

• Use the Dual-Dirac model to estimate the jitter to a 10-9 BER. Total Jitter (TJ) is estimated as

TJ= DJdd + n* RJ, Where

RJ: Random jitter

n: 12 ( to accommodate a Bit Error Ratio value of 1*10-9
• Compare the result with the limits specified in the VESA specification.

HBR2 D10.2 Total Jitter/Random jitter/Deterministic jitter (TJ/RJ/DJ)
measurement (Normative)
This measurement evaluates the total jitter at 10-9. This can be measured explicitly at this rate or through an approved estimation
technique.

Measurement details
This measurement is performed in the following test conditions:

Data rate HBR2

Test Point TP3_EQ

Pattern D10.2

Voltage Swing Any passing Eye setting

Pre-Emphasis Any passing Eye setting

SSC SSC Enabled

SSC Disabled

Lanes to be tested All lanes supported

• To get TP3_EQ, waveform is captured at TP2 and Cable emulator applied in SW.
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• The eye diagram test should pass both ‘worst case cable’ and a ‘zero length cable’ model.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Capture 1M Unit Intervals.
• Use the following clock recovery values:

Data rate RBR HBR HBR2 HBR3

PLL Type 2nd Order 2nd Order 2nd Order 2nd Order
Bandwidth 5.4 MHz 10 MHz 10 MHz 15 MHz
Damping 1.51 1.51 1.0 1.0

• To achieve the worst case cable model (Where ever applicable, for the selected data rate), capture the signal at TP2 and apply the
worst case cable emulator using the MATH subsystem in the oscilloscope.

• To achieve the ‘zero length cable’, capture the signal at TP2 and do not embed any cable model.
• For HBR and HBR2 data rate needs Equalization. For each of the acquisitions above, the Analyzer applies a CTLE (Continuous Time

Linear Equalization) Transfer Function as defined in VESA specification.
• For HBR3 Data rate needs Equalization. For each of the acquisitions above, the Analyzer applies the 10 CTLE (Continuous Time

Linear Equalization) Transfer Function and creates set of waveform and clock information for each of the CTLE waveforms. The CTLE
waveform is then passed to the VESA DFE tool which provides the optimal CTLE and DFE tap value as defined in VESA specification.
The VESA DFE tool needs to be installed separately and is not part of the Tektronix DisplayPort installer.

• Use the Dual-Dirac model to estimate the jitter to a 10-9 BER. Total jitter (TJ) is estimated as

TJ = DJdd + n* RJ, Where

RJ: Random jitter

n: 12 ( to accommodate a Bit Error Ratio value of 1*10-9
• Compare the result with the limits specified in the VESA specification.

Main link frequency compliance (Normative)
This measurement ensures that the average data rate under all conditions does not exceed minimum or maximum as set by the standard.

Measurement details
This measurement is performed in the following test conditions:

Data rate All supported bit rates

Test Point TP2

Pattern D10.2

Voltage Swing Level 2

Pre-Emphasis 0 dB

Table continued…
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SSC SSC Enabled

SSC Disabled

Note: If SSC is both, then test with SSC Enabled only.

Lanes to be tested All lanes

• If the measurement is performed with SSC, then at least 10 full SSC cycles is required.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Set the horizontal settings such that at least 10 full cycles (when SSC is enabled) OR 33usec duration (when SSC is disabled).
• Find the average data rate/Frequency.
• Compare the result with the limits specified in the VESA specification.

Spread spectrum modulation frequency (Normative)
This measurement evaluates the Spread Spectrum modulation frequency modulation. 

Measurement details
This measurement is performed in the following test conditions:

Data rate Highest bit rate supported

Test Point TP2

Pattern D10.2

Voltage Swing Level 2

Pre-Emphasis 0 dB

SSC SSC Enabled

Lanes to be tested All lanes

• An evaluation of at least 10 full SSC cycles is required and Mean value should be reported.
• Devices that do not have SSC Enabled shall not be tested.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Set the horizontal settings such that at least 10 full cycles are captured.
• Find the period trend with low pass filter with 2nd order Butterworth with a 3dB corner frequency of 1.98MHz (to remove the non-SSC

jitter components). Find the mean frequency of the period trend compare this with the limits as specified in the VESA specification.
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Spread spectrum modulation (Normative)
This measurement evaluates the range of the SSC down-spreading of the transmitter signal.

Measurement details
This measurement is performed in the following test conditions:

Data rate Highest bit rate supported

Test Point TP2

Pattern D10.2

Voltage Swing Level 2

Pre-Emphasis 0 dB

SSC SSC Enabled

Lanes to be tested All lanes

• An evaluation of at least 10 full SSC cycles is required and Mean value should be reported.
• Devices that do not have SSC Enabled shall not be tested.

Measurement
• Perform the vertical settings such that the waveform occupies 8 divisions.
• Set the horizontal settings such that at least 10 full cycles are captured.
• Find the period trend with low pass filter with 2nd order Butterworth with a 3dB corner frequency of 1.98MHz (to remove the non-SSC

jitter components).
• For each cycle, the minimum and maximum data rate is evaluated, and for all such cycles the maximum, minimum and optional

average data rates are determined. The range is calculated as follows:

SSC range = {[Average(RateMin values) – Average(RateMax Values)] / Nominal Data Rate } * 1e6
• Compare the result with the limits specified in the VESA specification.

dF-dt spread spectrum deviation HF variation (Informative)
This measurement verifies whether the SSC profile does not include any frequency deviation which would exceed 1250ppm/uSec.

Measurement details
This measurement is performed in the following test conditions:

Data rate Highest bit rate supported

Test Point TP2

Pattern D10.2

Table continued…
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Voltage Swing Level 2

Pre-Emphasis 0 dB

SSC SSC Enabled

Lanes to be tested All lanes

• An evaluation of at least 10 full SSC cycles is required andpeak dF/dT value should be reported.
• Devices that do not have SSC Enabled will not be tested.

Measurement
The algorithm runs as follows:

• Perform the vertical settings such that the waveform occupies 8 divisions.
• Set the horizontal settings such that at least 10 full cycles are captured.
• Find the period trend with low pass filter with 2nd order Butterworth with a 3dB corner frequency of 1.98MHz (to remove the non-SSC

jitter components).
• Once the filtered SSC profile is established, a ‘sliding window’ is moved across the profile values to compute the slope. This window

has a width of 0.27us, and the slope value for each horizontal point is calculated from the difference equation:

Slope = (f(t)-f(t-0.27 usec))/0.27us.
• Compare the peak result with the limits specified in the VESA specification.

Dual mode TMDS clock (Normative if supported)
This measurement confirms that the TMDS clock waveform of a source operating in dual-mode does not exceed acceptable limits.

Measurement Algorithm
Confirm that the duty cycle of the TMDS clock waveform of a source operating in dual-mode does not exceed acceptable limits. Confirm
that the wavefrom does not carry excessive jitter.

The algorithm runs as follows:

1. Put the device in the mode which transmits the maximum TMDS clock rate supported by the DUT.
2. Based on the frequency of clock, generate the mask.
3. Capture TMDS Clock with at least 400,000 clock periods.
4. Measure the duty cycle, Mask Hit and Jitter.

The measurement is a pass if:

• 40% < TMDS_CLOCK duty cycle < 60%
• Mask Hits = 0
• For 25 MHz ≤ TMDS Clock Frequency ≤ 165 MHz: Measured TMDS Clock Jitter ≤ 0.20 Tbit
• For 165 MHz < TMDS Clock Frequency ≤ 300 MHz: Measured TMDS Clock Jitter ≤ 120 ps
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Dual mode eye diagram testing (Normative if supported)
This measurement evaluates the waveform and ensures that timing variables and amplitude trajectories meet the requirements for a
dual-mode source device.

Measurement Algorithm
The algorithm runs as follows:

1. Put device in the mode which transmits the maximum TMDS clock rate supported by the DUT and capture clock as well as data on all
the lanes simultaneously.

2. Select and run Mask Hits test and TIE measurement from DPOJET.
3. Evaluate results for over 400,000 UI.

The measurement is a pass if

• Mask Hits = 0
• 25 MHz ≤ TMDS Clock Frequency ≤ 165 MHz: Data Jitter ≤ 0.25 Tbit
• 165 MHz < TMDS Clock Frequency ≤ 300 MHz: Data Jitter ≤ 150 ps

AUX channel eye diagram testing
This measurement checks if AUX channel waveform timing variables and amplitude trajectories support the DisplayPort system.

Measurement Algorithm
This measurement checks if the Eye opening for the data transmitted by the Aux channel of the DUT is within limits. As the data comes in
as a burst, cursors are used. The following are the steps for the measurement:

1. Initiate an AUX transaction from the DUT. Capture the burst of data transmitted by the DUT.
2. Find the edges from the burst. Edges are found such that at least 38 edges are available measurement (16 SYNC pulses, SYNC End,4

data bits).
3. Mask Hit measurement and eye height measurement are run using DPOJET.
4. Steps 1-3 are repeated for 10 times and results are picked up from DPOJET.

The measurement is a pass if Eye height > 290 mV and there are no mask hits.

AUX channel eye sensitivity test
This measurement evaluates the sensitivity to the AUX CH EYE opening of the DUT.

Measurement Algorithm
The test verifies the EYE sensitivity of the AUX receiver in the DUT, by controlling the voltage swing of the AUX transmitter in the
Reference device. The Reference device shall set the AUX differential voltage swing to 280 mV_diff_pp at its connector. Stimulus shall be
applied to either the Reference device or DUT to cause AUX CH transactions to occur. This stimulus shall not be included in or affect the
measurement.

The algorithm runs as follows:

1. Set Reference Source AUX channel voltage swing to a level between 240 mV and 280 mV_diff_pp as measured at its connector.
2. Induce an AUX transaction to setup the DUT to transmit a specific pattern.
3. Determine whether AUX channel communication takes place successfully by checking if the requisite pattern was transmitted.

Algorithms
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4. Repeat steps 2 and 3 twenty (20) times.

The measurement is a Pass if no errors are observed.

Inrush test
This measurement evaluates the Inrush energy at the power supply input of a power consuming DUT or to evaluate the inrush tolerance at
the power supply output of a power providing DUT.

Measurement Algorithm
1. Connect the VTM Inrush Test Fixture (VITF) to the source DUT’s DP interface port.
2. Power on the VTM fixture using the USB-Mini USB cable connected to one of the oscilloscope’s USB ports.
3. Plug the TCP202 Current Probe into CH1 of the oscilloscope, using a TCABNC input adapter. Connect the current probe head to the

current-sense loop on the VITF.
4. Plug the P6246/ P6247 differential probe into CH2 of the oscilloscope using a TCABNC input adapter. Set the P6246/ P6247 probe

switches to DC Reject = On, BW = 200MHz, and Attenuation ÷10. Using a square-pin adapter for the P6246/ P6247 probe tip,
connect the probe inputs to the VITF, Connector P4, pins 2 and 4. (Alternatively, direct connection using SMA cables between the
VTM fixture and the oscilloscope can also be used.

5. Select “Default Setup” using the oscilloscope’s front panel button.
6. From Horizontal Setup menu, set horizontal scale to 10.0 µs/div and sample rate to 25 GS/s (Constant Sample Rate). Check that

record length is set to 2.5 M
7. From the Vertical Setup menu, set vertical scale for CH1 to 2.0 A/div as a starting point.
8. Set CH1 bandwidth to 500MHz and CH2 vertical scale to 500 mV/div, BW = 500 MHz.
9. Set trigger for CH1, Positive Edge and set the trigger level as 2A.
10. Move the trigger point near the left-hand side of the scope display. Set it to 10%.
11. From the Math menu set Math1 = ArbFlt(CH1*CH2) to display Power.
12. For the arbitrary filter, load the filter for “LowPass-norm, 0.05bw” which will reduce spurious noise on the math display.
13. Set Math1 vertical scale to 2W/div, scale 10 µs.
14. Move CH1, CH2, and Math1 vertical position to -3.5 div, so it will be near the bottom of the display.
15. From the Measurement setup menu, navigate to “More” àArea measurement for Math 1 to measure the area under the power curve.

The result will come in Ws (Watt-second) format.
16. “Clear” the current acquisition on the oscilloscope. Enable “Single” Acquisition.
17. To test inrush from a Source device, press the source test button (grey button) on the VITF. (Can’t be automated need to give user

pop up)
18. Observe the oscilloscope main display to see that the current inrush signal at Ch1, Voltage signal at Ch2 and Power signal at Math1.

The area under the power curve is calculated to measure energy.
19. Please convert value of TekScope measurement Area µWs (micro Watt-second) to mJoules (milliJoules ) after dividing by 1000.
20. Compare the Area with the spec limit stipulated in the CTS to determine if the DUT meets the requirement for <0.4 mJoules. The

device passes if the measured energy is <0.4 mJoules.

AUX slew rate
This test evaluates the AUX signaling edge rates to minimize crosstalk to main link signals.

Measurement Algorithm
This measurement checks slew rate for the Aux channel of DUT is within specified limits.
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1. Initiate an AUX transaction from the DUT. Capture the burst of data transmitted by the DUT.
2. Calculate Vaux_PP_diff as the Vpp mean of the Aux voltage level ignoring any overshoot or ringing following the positive or negative

transition.
3. Calculate the Rise Time and Fall Time for all the edges- T20-80%.
4. Calculate the Worst RT/FT as min(RT,FT)-T20-80%_min.
5. Slew Rate = (Vaux_PP_diff*0.6)/ T20_80%_min (V/ns).

Algorithms
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Installation instructions for testing Alpine Ridge DUT

DUT Settings
This section describes about the settings required for the PC to test Alpine Ridge DUT.

Install the TenLira software on the PC (DUT)
TenLira is a software utility used to control the Alpine Ridge DUT provided by Intel corporation. The electrical test scripts are bundled with
Tenlira software which are used to control the DUT.

Complete the below steps to install the TenLira software on the PC:

1. Browse to www.tek.com
2. Click Downloads.
3. Select Download type as Software and type "DisplayPort-Tx - DPO-DSAMSO70000- C, D, DX, SX - Win10" in keyword section.
4. Click Search.
5. Download the latest version of the software.
6. Close all the applications, including TekVISA applications.
7. Double-click on the executable file to extract the installation files.
8. After extraction, the installer launches and the software automatically installs in the location C:\Program Files\Tektronix. This location

consists of a folder named DP TenLira.

You can also download TenLira software from Intel Business Link (IBL) library. Obtaining the TenLira software and compliance
scripts requires that you have access to the IBL portal to download the necessary files.

Script setup
After you install the TekExpress software, the TBT Electrical folder gets automatically created in the location C:\Program
Files\Tektronix\DP TenLira\. This folder contains DPInterfaces.dll and TekDispTekLiraDUTController.exe files. Double-
click the executable file to install the TenLira DUT controller.

TCL istallation
You need TCL version 8.5 software which is installed in a 64-bit PC to run the test scripts.

Complete the below steps to install the TCL software:

1. Go to http://www.activestate.com/activetcl/downloads and download the latest TCL software.
2. Double-click the executable file and complete the installation process.

Note: TCL software should be used as per the ActiveState license agreement.

Controlling the DUT
This section describes the steps to automate the Alpine Ridge DUT using Tektronix TekDispTenLiraDutController.exe.

Pre-requisite: Connect oscilloscope and DUT to the same network
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1. Copy WMI_MOF.reg and acpimof.dll files from C:\Program Files\Tektronix\DP TenLira\TBT Electrical\ACPI_FP and paste in the location
C:\Windows\System32 .

2. Select WMI_MOF.reg file, right-click and select Merge.
3. Reboot the PC.
4. Navigate to C:\Program Files\Tektronix\DP TenLira and double-click TekDispTenLiraDutController.exe..
5. Allow firewall access for TekDispTenLiraDutController.exe.
6. Retain the default settings in the TekDispTenLiraDutController, because the scripts required to run are loaded through the default

settings.
7. To change the template,select Use Custom Template Path, click Browse and select the custom template.

You can also manually execute the commands in the command prompt.

C:\Program Files\Tektronix\DP TenLira\TBT Electrical\ACPI_FP\TBT_FP.vbs True
 "tclsh85 DP_Host_TX.tbc <BW> <Pattern> <SwingLevel> <Reemphasis> <Sink> <Source>" 
     
 <DP> : Host/Device
    <BW> : 5.4/2.7/1.62 
    <Pattern> : PRBS7/D10.2/PLTPAT/HBR2CPAT
 <SwingLevel> : 0/1/2 
    <PreEmphasis> : 0/1/2 
    <Sink> : sink1/sink2 
 <Source> : PA/PB/SRC0 
     

Example

C:\TBT Electrical\DP\TBC>tclsh85 DP_Device_Tx.tbc 5.4 PRBS7 0 0 sink1 PA

The above example explains about configuring port PA to Data Rate as 5.4 Gbps; Pattern as PRBS7 ; Swing as 0; PreEmphasis as 0
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Oscilloscope settings
This section describes the steps to setup the connection between the oscilloscope and DUT.

• Connect the instruments as shown in below figure setup diagram.
• Switch the DUT into DisplayPort mode by plugging in Type C pin into DisplayPort.

1. Install TekExpress Displayport latest version on oscilloscope and launch the application.
2. In oscilloscope select type C in connector type under DUT setup.
3. Go to Test Mode and select TenLira. Enter IP address of DUT in the popup. Press Test Connection and check whether the connection

between the oscilloscope and DUT is established successfully through reference sink.
4. In the Test Selection panel, select the tests which should be executed.
5. Click Start to start the test execution.

When the test execution starts the log results are displayed in the Tektronix TekDispTenLiraDutController window as shown below.
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Troubleshooting
If any communication error is occurred then check for the following confirmations:

• TCL v8.5 is installed.
• WMI_MOF.reg & acpimof.dll has been copied to system32 and registry is merged and system is rebooted.
• Ref sink is connected in between the oscilloscope and DUT.
• DUT is in DisplayPort mode

For further details refer to the document Thunderbolt Electrical Compliance - Type C Host Test scripts Rev 0.8.pdf. This document is the
part of TenLira installer.
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TekExpress programmatic interface

About the programmatic interface
The Programmatic interface seamlessly integrates the TekExpress test automation application with the high-level automation layer. This
also lets you control the state of the TekExpress application running on a local or a remote computer. 

The following terminology is used in this section to simplify description text:

• TekExpress Client: A high-level automation application that communicates with TekExpress using TekExpress Programmatic
Interface.

• TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client. TekExpress provides a client library for
TekExpress clients to use the programmatic interface. The TekExpress client library is inherited from .Net MarshalByRef class to provide
the proxy object for the clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference allows the
client to control the server state.

See also
Requirements for developing TekExpress client

To enable remote access
To access and remotely control an instrument using the TekExpress programmatic interface, you need to change specific firewall settings
as follows: 

1. Access the Windows Control Panel and open the Windows Firewall tool (Start > Control Panel > All Control Panel Items >
Windows Firewall).

2. Click Advance Settings > Inbound Rules.
3. Scroll through the Inbound Rules list to see if the following items (or with a similar name) are shown:

• TekExpress DisplayPort
• TekExpress

TekExpress programmatic interface
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4. If both items are shown, you do not need to set up any rules. Exit the Windows Firewall tool.
5. If one or both are missing, use the following procedure to run the New Inbound Rule Wizard and add these executables to the rules to

enable remote access to the TekExpress application.
6. On the client side include Client application.exe through which TekExpress application is remotely controlled. For example if the

application is controlled using python scripts then "ipy64.exe" should be included as part of Inbound rules.

Run the new Inbound Rule wizard
1. Click on New Rule (in Actions column) to start the new Inbound Rule wizard.

2. Verify that Program is selected in the rule type panel and click Next.
3. Click Browse in the program panel and navigate to and select one of the following TekExpress applications (depending on the one

for which you need to create a rule):
4. TekExpress DisplayPort.exe
5. TekExpress.exe

Note: See for the path to the application files.

6. Click Next.
7. Verify that Allow the connection is selected in the Action panel and click Next.
8. Verify that all fields are selected (Domain, Private, and Public) in the Profile panel and click Next.
9. Use the fields in the Name panel to enter a name and optional description for the rule. For example, a name for the TekExpress

DisplayPort application could be TekExpress DisplayPort Application. Add description text to further identify the rule.
10. Click Finish to return to the main Windows Firewall screen.
11. Scroll through the Inbound Rules list and verify that the list shows the rule that you just entered.
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12. Repeat steps1 through 11 to enter the other TekExpress executable if it is missing from the list. Enter TekExpress PI as the name.
13. Scroll through the Inbound Rules list and verify that the list shows the rule that you just entered.
14. Exit the Windows Firewall tool.

To use the remote access:
1. Obtain the IP address of the instrument on which you are running TekExpress DisplayPort. For example, 134.64.235.198.
2. On the PC from which you are accessing the remote instrument, use the instrument IP address as part of the TekExpress DisplayPort

PI code to access that instrument. For example:
object obj = piClient.Connect(“134.64.235.198”,out clientid);

Requirements for developing TekExpress client
While developing TekExpress Client, use the TekExpressClient.dll. The client can be a VB .Net, C# .Net, Python, or Web application. The
examples for interfaces in each of these applications are in the Samples folder. 

References required
• TekExpressClient.dll has an internal reference to IRemoteInterface.dll.

• IRemoteInterface.dll provides the interfaces required to perform the remote automations. It is an interface that forms the
communication line between the server and the client.

Note: The end-user client application does not need any reference to the above mentioned DLL files. It is essential to have these
DLLs (IRemoteInterface.dll and TekDotNetLib.dll) in the same folder as that of TekExpressClient.dll.

Required steps for a client
The client uses the following steps to use TekExpressClient.dll to programmatically control the server:

Develop a client UI to access the interfaces exposed through the server. This client loads TekExpressClient.dll to access the
interfaces. After TekExpressClient.dll is loaded, the client UI can call the specific functions to run the operations requested by
the client. When the client is up and running, it does the following to run a remote operation:

1. To connect to the server, the client provides the IP address of the PC where the server is running.
2. The client locks the server application to avoid conflict with any other Client that may try to control the server simultaneously. “Lock”

would also disable all user controls on the server so that server state cannot be changed by manual operation.

If any other client tries to access a server that is locked, it will receive a notification that the server is locked by another client.
3. When the client has connected to and locked the server, the client can access any of the programmatic controls needed to run the

remote automation.
4. After the client operations finish, the client unlocks the server.

Remote proxy object
The server exposes a remote object to let the remote client access and perform the server-side operations remotely. The proxy object is
instantiated and exposed at the server-end through marshalling.
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The following is an example:
RemotingConfiguration.RegisterWellKnownServiceType (typeof
(TekExpressRemoteInterface), “TekExpress Remote interface”,
WellKnownObjectMode.Singleton);
This object lets the remote client access the interfaces exposed at the server side. The client gets the reference to this object when the
client gets connected to the server.

For example,

//Get a reference to the remote object
remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),
URL.ToString());

Client proxy object
Client exposes a proxy object to receive certain information.

For example,

//Register the client proxy object
WellKnownServiceTypeEntry[] e =
RemotingConfiguration.GetRegisteredWellKnownServiceTypes();
clientInterface = new ClientInterface();
RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface), “Remote
Client Interface”, WellKnownObjectMode.Singleton);
//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");
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The client proxy object is used for the following:

• To get the secondary dialog messages from the server.
• To get the file transfer commands from the server while transferring the report.

Examples
clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);
clientObject.clientIntf.TransferBytes(buffer, read, fileLength);
For more information, click the following links:

Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a client is performing the
automation at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked and if a remote connection is
detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by calling the file transfer methods at
the client-end.
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Client programmatic interface example
An example of the client programmatic interface is described and shown as follows:

Note: You can find programmatic interface examples under TekExpress DisplayPort Tx\Examples.

1. Connect to a server or remote object using the programmatic interface provided.
2. Get the client ID that is created when connecting to the remote object. This client ID is one of the required parameters to

communicate with the server.
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Note: The server identifies the client with this ID only and rejects any request if the ID is invalid.

3. Lock the server for further operations. This disables the application interface.

Note: You can get values from the server or set values from the server to the client only if the application is locked.

4. Register for receiving notifications on status change events on the server. To register you need to give a handler as a parameter.

Note: Whenever there is a change in the status of the server, all the clients registered with the server receive a notification
from the server.

5. Select the tests that you want to run through the programmatic interface.
6. Set the necessary parameters for each test.
7. Run the tests.
8. Poll for the status of the application.

Note: Skip step 8 if you are registered for the status change notification and the status is Ready.

9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server after you complete all the tasks.
12. Disconnect from the remote object.

Handler of status change notification
1. Get the status. If the status is Wait or Error, get the information that contains the title, message description, and the expected

responses for the status.
2. Perform the actions based on the status information.
3. Set the response as expected.

See also
Program remote access code example

Program remote access code example
This code example shows how to communicate between a remote PC and TekExpress DisplayPort. 

Table 17: Remote access code example

Task Code

Start the application

Connect through an IP
address.

'assigns client IP address to variable clientID; address valid until connection or measurement session ends
(Disconnect). See Connect()
clientID = “ ”
m_Client.Connect("localhost",out clientID)'True or False

Lock the server m_Client.LockServer(clientID)
Table continued…
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Task Code

Disable the Popups m_Client.SetVerboseMode(clientID, false)

Set the DUT ID m_Client.SetDutId(clientID, "DUT_Name")

Run with set
configurations

m_Client.Run(clientID)

Wait for the test to
complete.

Do
Thread.Sleep(500)
m_Client.Application_Status(clientID)
Select Case status
Case "Wait"

Get the current state
information

mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption,
WaitingMsbBxMessage, WaitingMsbBxButtontexts)

Send the response mClient.SendResponse(clientID, WaitingMsbBxCaption,
WaitingMsbBxMessage, WaitingMsbBxResponse)
End Select
Loop Until status = "Ready"

Save results 'Save all results values from folder for current run
m_Client.TransferResult(clientID, logDirname)

Unlock the server m_Client.UnlockServer(clientID)

Disconnect from server m_Client.Disconnect(clientID)

Exit the application

DisplayPort programmer interface commands

ApplicationStatus()
ApplicationStatus(clientId)

This method gets the status (ready, running, paused) of the server application.

Parameters

Name Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable
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clientId variable

clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Return value

String value that gives the status of the server application.

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client
DLL.
returnval as string
returnval=m_Client.ApplicationStatus(clientID)
Comments

The application is in the Running, Paused, Wait, or Error state at any given time.

Related command(s)

GetCurrentStateInfo

SendResponse

Status

Connect()

Connect(string HostIPAddress, out string clientID)
This command connects the client to the server; address is the IP address of the server to which the client is trying to connect. This is
required to establish the connection between the client and the server.

Note: The server must be active and running for the client to connect to the server. Any number of clients can be connected to the
server at a time.

Parameters

Parameter Type Direction Description

HostIPAddress string IN Obtains the IP address of the server to which the client is
trying to connect. This is required to establish the connection
between the server and the client.

Table continued…
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Parameter Type Direction Description

clientId string OUT Identifier of the client that is performing the remote function.

clientId variable

Return value
Value that indicates the connection status (connection was established or an error occurred). The return value can be a boolean value
(true), or a string (returning the error message).

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Example
try {
m_Client = new Client() //m_Client is a reference to the Client class in the Client DLL

clientID = “ ”
m_Client.Connect("localhost",out clientID)'True or False
}

Comments
The server has to be active and running for the client to connect to the server. Any number of clients can be connected to the server at a
time. Each client will get a unique id.

Related command(s)
Disconnect

Disconnect()

Disconnect(clientId)
This command disconnects the client from the server it is connected to.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable
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Return value
Integer value that indicates the status of the operation upon completion.

1: Success

–1: Failure

Example
try
{
string returnVal = UnlockServer (clientId);
remoteObject.Disconnect (clientId);
return 1;
}

Comments
When the client is disconnected, it is unlocked from the server and then disconnected. The id is reused.

Related command(s)
Connect

GetCurrentStateInfo()

GetCurrentStateInfo(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage, WaitingMsbBxButtontexts)
This command gets the additional information of the states when the application is in Wait or Error state.

Except client ID, all the others are Out parameters.

Note: This command is used when the application is running and is in the wait or error state.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable

WaitingMsbBxCaption string OUT The wait state or error state message sent to you

WaitingMsbBxMessage string OUT The wait state/error state message sent to you

WaitingMsbBxButtontexts string array OUT An array of strings containing the possible response types that
you can send
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clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Return value
This command does not return any value.

This function populates the Out parameters that are passed when invoking this function.

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client DLL

mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage, WaitingMsbBxButtontexts)

Comments

Related command(s)
ApplicationStatus

SendResponse

GetDutId()

GetDutId(clientId, out dutId)
This command returns the DUT id of the current set-up.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable

dutId string OUT The DUT id of the setup.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:

TekExpress programmatic interface

TekExpress® DisplayPort Automated Solution Application Help 145



clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String value that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.GetDutId(clientId, out dutId);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
{
return id;
}
else
return CommandFailed(returnVal);

Comments
The dutId is an OUT parameter whose value is set after the server processes the request.

Related command(s)
SetDutId

GetPassFailStatus()

GetPassFailStatus(clientId, device, suite, test)
This command gets the pass or fail status of the measurement after test completion.

Note: Execute this command after completing the measurement.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

device string IN Valid value is Source.

suite string IN Valid value is Source

test string IN Specifies the name of the test for which to obtain the pass or fail status.
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Return value
String value that indicates the status of the operation upon completion.

Example
GetPassFailStatus(clientId, "Device", "Source", "Eye diagram testing");

GetReportParameter()

GetReportParameter(clientId, device, suite, test, parameterString)
This command gets the general report details such as oscilloscope model and TekExpress version.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

device string IN Specifies the DUT type (Device).

suite string IN Valid value is Source

test string IN Specifies the name of the test for which to obtain the pass or fail status.

parameterString string IN Specifies to return the measured value for the indicated test. Enter
“Scope Model” , “TekExpress Version”, or “Application Version” for this
argument

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Return value
The return value is the connected oscilloscope model, TekExpress base software version, or DPTX application version.

Example
GetReportParameter(clientId, “Device”, “Source”, “”, "Application Version")

GetResultsValue()

GetResultsValue(clientId, device, suite, test, parameterString)
This command gets the result values of the specified measurement after the run.

TekExpress programmatic interface

TekExpress® DisplayPort Automated Solution Application Help 147



Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

device string IN Specifies the DUT type (Device).

suite string IN Valid value is Source

test string IN Specifies the name of the test for which to obtain the test result
value.

"Eye diagram testing"

"Non Pre-Emphasis Level Verification Testing"

"Pre-Emphasis Level Verification"

"HBR2/HBR3 Level and Equalization Verification Testing"

"Inter-Pair Skew Test" "Test 3.5_Intra-Pair Skew Test"

"AC Common Mode Noise Measurements"

"Non ISI Jitter Measurements"

"Total Jitter (TJ) Measurements"

"Random Jitter (RJ) Measurements"

"Main Link Frequency Compliance"

"Spread Spectrum Modulation Frequency"

"Spread Spectrum Modulation Deviation"

"dF/dt Spread Spectrum Deviation HF Variation"

“Dual-mode TMDS Clock”

“Dual-mode Eye diagram testing”

“AUX Manchester Channel EYE Test”

“AUX Manchester Channel Sensitivity Test”

"Inrush Test"

"AUX Slew Rate"

parameterString string IN Specifies to return the measured value for the indicated test. Enter
“Value” for this argument or one of the Column names

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Return value
String value that indicates the status of the operation upon completion. Returns the result value in the form of a string.

Example
GetResultsValue(clientId, “Device”, “Source”, "Eye diagram testing”, "Value");

LockServer()

LockServer(clientId)
This command locks the server. The client has to call this command before running any of the remote automations. The server is locked by
only one client.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
Returns the status of the operation upon completion.

Example
if (locked)
return “Server has already been locked!”;
returnVal = remoteObject.LockServer(clientId);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
{
locked = true;
return “Server Locked...”;
}

Comments
When the client tries to lock a server that is locked by another client, the client gets a message that the server is already locked and it has
to wait until the server is unlocked.
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If the client locks the server and is idle for a certain amount of time, then the server is automatically unlocked from that client.

Related command(s)
UnlockSession

RecallSession()

RecallSession(clientId,sessionName)
Recalls a saved session. The name of the session is provided by the client.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is performing the remote function.

clientId variable

sessionName string IN The name of the session being recalled.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.RecallSession(clientId,sessionName);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Session Recalled...”;
else
return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Related command(s)
SaveSession

SaveSessionAs
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Run()

Run(clientId)
Runs the setup. Once the server is set up and configured, it can be run remotely using this function.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that returns the status of the operation after completion.

Example
returnVal = remoteObject.Run(clientId);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Run started...”;
else
return CommandFailed(returnVal);

Comments
When the run is performed the status of the run is updated periodically using a timer.

SaveSession()

SaveSession(clientId,sessionName)
Saves the current session. The name of the session is provided by the client.
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

sessionName string IN The name of the session being saved.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.SaveSession(clientId,sessionName);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Session Saved...”;
else
return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name,’ you cannot use this command to save the session with a different name. Use SaveSessionAs to
save the session to a new name.

Related command(s)
RecallSession

SaveSessionAs

SaveSessionAs()

SaveSessionAs(clientId,sessionName)
Saves the current session in a different name every time this command is called. The name of the session is provided by the client.

TekExpress programmatic interface

152



Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

sessionName string IN The name of the session being saved.

Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.SaveSessionAs(clientId,sessionName);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Session Saved...”;
else
return CommandFailed(returnVal);

Comments
The same session is saved under different names using this command. The name parameter cannot be empty. If it is empty, the client is
prompted to provide a valid name.

Related command(s)
RecallSession

SaveSession

SendResponse()

SendResponse(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage, WaitingMsbBxButtontexts)
After receiving the additional information using the command GetCurrentStateInfo(), the client can decide which response to send and
then send the response to the application using this function. The response should be one of the strings that was received earlier as
a string array in the GetCurrentStateInfo function. The _caption and _message should match the information received earlier in the
GetCurrentStateInfo function.

Note: This command is used when the application is running and is in the wait or error state.
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

WaitingMsbBxCaptio
n

string OUT The wait state or error state message sent to you

WaitingMsbBxMessa
ge

string OUT The wait state/error state message sent to you

WaitingMsbBxButtont
exts

string array OUT An array of strings containing the possible response types that you
can send

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Return value
This command does not return any value.

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client DLL

mClient.SendResponse(clientID, out WaitingMsbBxCaption, out WaitingMsbBxMessage, out WaitingMsbBxButtontexts)

Related command(s)
ApplicationStatus

GetCurrentStateInfo

SelectDevice()

SelectDevice(clientId, device, true)
This command selects the DUT type (Host or Device).
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

device string IN Specifies the DUT type (Device)

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String value that indicates the status of the operation upon completion.

Example
SelectDevice(clientId,"Device")

SelectSuite()

SelectSuite(clientId, device, suite, true)
This command selects one of the two suites: "Host to Module" or "Module to Host."

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

device string IN Specifies the DUT type (Device)

suite string IN string with device connection type. Valid value is Source.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.
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Return value
String value that indicates the status of the operation upon completion.

Example
SelectSuite(clientId,"Device","Source",true);

SelectTest()

SelectTest(clientId, device, suite, test, true)
This command selects a test.

Table 18: Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

device string IN Specifies the DUT type (Device).

suite string IN string with device connection type. Valid value is Source.

Table continued…
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Parameter Type Direction Description

test string IN Name of the DisplayPort test.

"Eye diagram testing"

"Non Pre-Emphasis Level Verification Testing"

"Pre-Emphasis Level Verification Testing And Maximum Peak-to-
Peak Differential Voltage Testing"

"HBR2/HBR3 Level and Equalization Verification Testing"

"Inter-Pair Skew Test"

"Intra-Pair Skew Test"

"AC Common Mode Noise Measurements"

"Non ISI Jitter Measurements"

"Total Jitter (TJ) Measurements"

"Random Jitter (RJ) Measurements"

"Main Link Frequency Compliance"

"Spread Spectrum Modulation Frequency"

"Spread Spectrum Modulation Deviation"

"dF/dt Spread Spectrum Deviation HF Variation"

“Dual-mode TMDS Clock”

“Dual-mode Eye diagram testing”

“AUX Manchester Channel EYE Test”

“AUX Manchester Channel Sensitivity Test”

“Inrush Test”

"AUX Slew Rate"

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String value that indicates the status of the operation upon completion.

Example
SelectTest(clientId, "Device", "Source", "Eye diagram testing", true);
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SetDutId()

SetDutId(clientID,newDutId)
This command changes the DUT ID of the setup. The client must provide a valid DUT ID.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

newDutId string IN The new DUT ID of the setup.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that gives the status of the operation after it was performed.

Return value is “DUT Id Changed” on success.

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client
DLL.
returnval as string
return=m_Client.SetDutId(clientID,desiredDutId)

Comments

Related command(s)
GetDutId

SetGeneralParameter()

SetGeneralParameter(clientId, device, suite, "", paramString)
This command sets the general parameter and its value based on the "paramString" argument values as listed.

TekExpress programmatic interface SetGeneralParameter()
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

device string IN Specifies the DUT type (Device)

suite string IN Valid value is Source

paramString string IN Specifies to return the measured value for the indicated test. Enter
“Value” for this argument or one of the Column names

Return value
String value that indicates the status of the operation upon completion.

List of available general parameters
Appviewmode$Compliance

Appviewmode$Advanced

RBR$Excluded

RBR$Included

HBR$Excluded

HBR$Included

HBR2$Excluded

HBR2$Included

HBR3$Excluded

HBR3$Included

PreEmphasis-0dB$Excluded

PreEmphasis-0dB$Included

PreEmphasis-3.5dB$Excluded

PreEmphasis-3.5dB$Included

PreEmphasis-6dB$Excluded

PreEmphasis-6dB$Included

PreEmphasis-9.5dB$Excluded

PreEmphasis-9.5dB$Included

Voltage swing-400mV$Excluded

Voltage swing-400mV$Included

Voltage swing-600mV$Excluded

Voltage swing-600mV$Included

Voltage swing-800mV$Excluded
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Voltage swing-800mV$Included

Voltage swing-1200mV$Excluded

Voltage swing-1200mV$Included

SSC$SSC Enable

SSC$SSC Disable

SSC$Both

Link Widths$1 Lane

Link Widths$2 Lanes

Link Widths$4 Lanes

Connector$Standard

Connector$Type C

DUT control$DP AUX

DUT control$DP AUX-Nvidia

DUT control$DPR-100

DUT control$Manual

DUT control$TenLira DPR-100

Enable DeEmbed Filter$Included

Enable DeEmbed Filter$Excluded

Signal Validation$Prompt if validation fails

Signal Validation$Skip test if validation fails

Signal Validation$Skip validation

Signal Validation$Validate pattern but use pattern as is

Controller$GRL

Controller$Dongle

Signal Validation : Data Rate$Included

Signal Validation : Data Rate$Excluded

Signal Validation : Pattern Type$Included

Signal Validation : Pattern Type$Excluded

Signal Validation : SSC$Included

Signal Validation : SSC$Excluded

DC Voltage$Auto

DC Voltage$Internal

DeEmbed Filter Path$Complete Path of filter file has to be updated

Example
SetGeneralParameter(clientId, "Device", "Source", "", "RBR$Included")
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SetTimeOut()

SetTimeOut(clientId, time)
Sets a timeout period specified by the client. After this timeout period expires, the server is unlocked automatically.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

time string IN The time in seconds that refers to the timeout period

Return Value
String value that indicates the status of the operation upon completion. On success the return value is “TimeOut Period Changed”.

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client DLL. returnval as string
returnval=m_Client.SetTimeOut(clientID, time)

Related command(s)
setTimeOut()

TekExpress programmatic interface setVerboseMode()

SetVerboseMode()

setVerboseMode(clientId, verboseMode)
This command sets the verbose mode to either true or false.

When the value is set to true, any message boxes that appear during the application are routed to the client machine that is controlling
TekExpress.

When the value is set to false, all the message boxes are shown on the server machine.
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

verboseMode boolean IN Sets the verbose mode to be turned ON (true) or OFF (false).

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that gives the status of the operation after it was performed. Returnval as string

When Verbose mode is set to true, the return value is “Verbose mode turned on. All dialog boxes will be shown to client”.

When Verbose mode is set to false, the return value is “Verbose mode turned off. All dialog boxes will be shown to server”.

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Example
m_Client = new Client() //m_Client is a reference to the Client class in the Client DLL.

Turn on verbose mode:
return=m_Client.SetVerboseMode(clientId, true)
Turn off verbose mode:
returnval=m_Client.SetVerboseMode(clientId, false)

Status()

Status(clientId, out statusMessages)
This command gives the status of the run as messages. The status messages are generated once the run is started.
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Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

statusMessage string array OUT The list of status messages generated during run.

Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.QueryStatus(clientId, out statusMessages);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Status updated...”;
else
return CommandFailed(returnVal);

Comments
The status messages are updated periodically after the run begins. The status is an out parameter which is set when the server processes
the request.

Related command(s)
ApplicationStatus (see page) TekExpress programmatic interface Stop()

Stop()

Stop(clientId)
Stops the run operation.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.
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Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.Stop(clientId);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Stopped...”;
else
return CommandFailed(returnVal);

Comments
When the session is stopped the client is prompted to stop the session and is stopped at the consent.

UnlockServer()

UnlockServer(clientId)
This command unlocks the server from the client. The client id of the client to be unlocked has to be provided.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return value
String that indicates the status of the operation upon completion.

Example
returnVal = remoteObject.UnlockServer(clientId);
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)
{
locked = false;
return “Server UnLocked...”;
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}

Comments
When the client is disconnected, it is automatically unlocked.

Related commands
LockSession

Handle error codes
The return value of the remote automation at the server-end is OP_STATUS, which changes to a string value depending on its code, and
returned to the client. The values of OP_STATUS are as follows:

Code Value Description

-1 FAIL The operation failed

1 SUCCESS The operation succeeded

2 NOT FOUND Server not found

3 LOCKED The server is locked by another client, so the operation cannot be performed

4 UNLOCK The server is not locked; lock the server before performing the operation

5 NULL Nothing

Note: The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another client".

If the session is UNLOCKED the command returns "Lock Session to execute the command".

If the server is NOTFOUND the command returns "Server not found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

SetComplianceMode()

SetComplianceMode(clientId, Mode)
This command sets the mode to user defined mode.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

Mode string IN Sets the mode to be tuned 'User-defined' or 'compliance'
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Example
Setting mode to user defined:
remoteClientObj.SetComplianceMode(id[1],"User-Defined")
Setting mode to Compliance:
remoteClientObj.SetComplianceMode(id[1],"Compliance")
After setting compliance mode, SetAcquireParameter() and SetAnalyzeParameter() commands can be used to set user defined values.

SetAquireParameter()

SetAcquireParameter(string clientID, string device, string suite, string test, string parameterString)
This method sets the parameter values in the Scope Settings tabs in the test configuration section.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server.

device string IN Specifies the name of the device.

suite string IN Specifies the name of the suite.

test string IN Specifies the name of the test to obtain the pass or fail status .

parameterString string IN Selects or deselects a test.

Return value
String that displays the status of the operation after it has been performed.

The return value is " " (an empty string) on success.

Example
Here parameterString is "Acquire_Type$parName$Parvalue"

returnval = remoteClientObj.SetAcquireParameter(id[1], device, suite," Test 3.1_Eye diagram testing"," PRBS7$Sample Rate (GS/s)$25")

List of Acquire parameter
PRBS7$RBR:Sample Rate(GS/s)$50

PRBS7$HBR:Sample Rate(GS/s)$50

PRBS7$HBR2:Sample Rate(GS/s)$50

PRBS7$HBR3:Sample Rate(GS/s)$50

PRBS7$RBR:Record Length(M)$20

PRBS7$HBR:Record Length(M)$20

PRBS7$HBR2:Record Length(M)$20
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PRBS7$HBR3:Record Length(M)$20

D10.2$RBR:Sample Rate(GS/s)$50

D10.2$HBR:Sample Rate(GS/s)$50

D10.2$HBR2:Sample Rate(GS/s)$50

D10.2$HBR3:Sample Rate(GS/s)$50

D10.2$RBR:Record Length(M)$20

D10.2$HBR:Record Length(M)$20

D10.2$HBR2:Record Length(M)$20

D10.2$HBR3:Record Length(M)$20

TMDS Clock$Record Length (M)$5

TMDS Clock$Sample rate (GS/s)$50

TMDS Clock$Edge trigger slope$Positive

TMDS EyeDiagram$Record Length (M)$5

TMDS EyeDiagram$Sample rate (GS/s)$50

TMDS EyeDiagram$Edge trigger slope$Positive

Aux EyeDiagram$Record Length (M)$2

Aux EyeDiagram$Sample rate (GS/s)$50

Aux EyeDiagram$ Edge trigger slope$Positive

Inrush$Record Length (M)$2.5

Inrush$hSample rate (GS/s)$50

Aux Slew Rate$ScaleTriggerSettings$Automatic

Aux Slew Rate$Record Length (M)$2

Aux Slew Rate$Sample rate (GS/s)$50

Aux Slew Rate$ Edge trigger slope$Positive

Aux Slew Rate$Scale(mV/div)$2

Aux Slew Rate$Trigger Level(Excluding Offset) (mV)$50

Aux EyeDiagram$ScaleTriggerSettings$Automatic

Aux EyeDiagram$Scale(mV/div)$2

Aux EyeDiagram$Trigger Level(Excluding Offset) (mV)$50

Aux Sensitivity$ScaleTriggerSettings$Automatic

Aux Sensitivity$Record Length (M)$2

Aux Sensitivity$Sample rate (GS/s)$50

Aux Sensitivity$ Edge trigger slope$Positive

Aux Sensitivity$Scale(mV/div)$2

Aux Sensitivity$Trigger Level(Excluding Offset) (mV)$50
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Aux Sensitivity$Calibrate Amplitude$True

SetAnalyzeParameter()

SetAnalyzeParameter(string clientID, string device, string suite, string test, string parameterString)
This method sets the parameter values in the Ref Levels and Clock Settings tabs in the test configuration section.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server.

device string IN Specifies the name of the device.

suite string IN Specifies the name of the suite.

test string IN Specifies the name of the test to obtain the pass or fail status .

parameterString string IN Selects or deselects a test.

Return value
String that displays the status of the operation after it has been performed.

The return value is " " (an empty string) on success.

Example
Here parameterString is "parName$Parvalue"

returnval = remoteClientObj.SetAnalyzeParameter(id[1],device,suite," Test 3.1_Eye diagram testing", "Clock recovery method$PLL-Custom
BW")

List of Analyze parameter
PRBS7$Clock recovery method$Constant Clock-Mean

PRBS7$Signal Type$CLOCK

PRBS7$PLL Model Type$ONE

PRBS7$RBR Damping (m)$1510

PRBS7$RBR Loop bandwidth (MHz)$5.4

PRBS7$HBR Damping (m)$1510

PRBS7$HBR Loop bandwidth (MHz)$10

PRBS7$HBR2 Damping (m)$1000

PRBS7$HBR2 Loop bandwidth (MHz)$10

PRBS7$HBR3 Damping (m)$1000

PRBS7$HBR3 Loop bandwidth (MHz)$10
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PRBS7$Ref Levels Autoset Basetop Method$MINMAX

PRBS7$Ref levels$Absolute

PRBS7$Mid level$-10

PRBS7$Hysteresis$-2

PRBS7$SDLA Config$CTLE

PRBS7$SDLA Config$CTLE, DFE

PRBS7$HBR3:CTLE Zero Cable$0dB

PRBS7$HBR3:CTLE Zero Cable$-1dB

PRBS7$HBR3:CTLE Zero Cable$-2dB

PRBS7$HBR3:CTLE Zero Cable$-3dB

PRBS7$HBR3:CTLE Zero Cable$-4dB

PRBS7$HBR3:CTLE Zero Cable$-5dB

PRBS7$HBR3:CTLE Zero Cable$-6dB

PRBS7$HBR3:CTLE Zero Cable$-7dB

PRBS7$HBR3:CTLE Zero Cable$-8dB

PRBS7$HBR3:CTLE Zero Cable$-9dB

PRBS7$HBR3:CTLE Zero Cable$All

PRBS7$HBR3:CTLE Worst Case Cable$0dB

PRBS7$HBR3:CTLE Worst Case Cable$-1dB

PRBS7$HBR3:CTLE Worst Case Cable$-2dB

PRBS7$HBR3:CTLE Worst Case Cable$-3dB

PRBS7$HBR3:CTLE Worst Case Cable$-4dB

PRBS7$HBR3:CTLE Worst Case Cable$-5dB

PRBS7$HBR3:CTLE Worst Case Cable$-6dB

PRBS7$HBR3:CTLE Worst Case Cable$-7dB

PRBS7$HBR3:CTLE Worst Case Cable$-8dB

PRBS7$HBR3:CTLE Worst Case Cable$-9dB

PRBS7$HBR3:CTLE Worst Case Cable$All

D10.2$Clock recovery method$Constant Clock-Mean

D10.2$Signal Type$CLOCK

D10.2$PLL Model Type$ONE

D10.2$RBR Damping (m)$1510

D10.2$RBR Loop bandwidth (MHz)$5.4

D10.2$HBR Damping (m)$1510

D10.2$HBR Loop bandwidth (MHz)$10

D10.2$HBR2 Damping (m)$1000
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D10.2$HBR2 Loop bandwidth (MHz)$10

D10.2$HBR3 Damping (m)$1000

D10.2$HBR3 Loop bandwidth (MHz)$10

D10.2$Ref Levels Autoset Basetop Method$MINMAX

D10.2$Ref levels$Absolute

D10.2$Mid level$-10

D10.2$Hysteresis$-2

TMDS Clock$Signal Type$CLOCK

TMDS Clock$Clock Edge$RISE

TMDS Clock$Clock recovery method$PLL-Custom BW

TransferImages()

TransferImages(clientId, filePath)
This command transfers all the images (screen shots) to the specified client and folder (directory from the current run.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server.

clientId variable

filePath string IN Enclose the path in quotes

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return Value
String value that indicates the status of the operation upon completion.

Transfers all the images in the form of a string.

Example
Images = remoteClientObj.TransferImages(id[1],"C:\\Images")
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GetResultsValueForSubMeasurements()

GetResultsValueForSubMeasurements(string clientID, string device, string suite, string test, string
parameterString, int rowNr)
This method gets the result values for individual submeasurements after the run.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server.

device string IN Specifies the name of the device

suite string IN Specifies the name of the suite.

test string IN Specifies the name of the test to obtain the pass or fail status.

parameterString string IN ParameterString string IN Specifies to return the measured value for the
indicated test.

int rowNr int IN The last parameter accepts the row number of table for that particular
test.

Return Value
String that gives the status of the operation after it has been performed .

Returns the result value in the form of a string.

Example
resultsValue_sub =
remoteClientObj.GetResultsValueForSubMeasurements(id[1],device,suite,measurement,"V
alue",2)

TransferResult()

TransferResult(clientId, logDirname)
This command transfers the report generated after the run to the specified folder (directory). The report contains the summary of the run.
The client has to use this command before the saved session command. The client has to provide the location where the report is to be
saved at the client-end.

Parameters

Parameter Type Direction Description

clientId string IN Identifier of the client that is connected to the server

clientId variable

Table continued…
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Parameter Type Direction Description

logDirname string IN Path to the target folder to which to transfer the report file.

Enclose the path in quotes.

clientId variable
clientId is a user-defined variable that stores the client ID address information. Use the Connect() command to fill this variable:
clientID = “ ”
m_Client.Connect("localhost",out clientId)'True or False
The clientId variable is stored until you call the Disconnect command.

Return Value
String that gives the status of the operation after it has been performed

Transfers all the result values in the form of a string.

Example
reports = remoteClientObj.TransferResult(id[1],"C:\\reports ")
Examples script files are present in installation directory. Refer the following path for accessing the examples, C:\Program
Files\Tektronix\TekExpress\TekExpress DisplayPortTx\Examples.
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TekExpress SCPI commands

About SCPI command
You can use Standard Commands for Programmable Instruments (SCPI) to communicate with the TekExpress application.

Socket configuration for SCPI commands
This section describes the steps for TCP/IP socket configuration and TekVISA configuration to execute the SCPI commands.

TCP/IP socket configuration
1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule…
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3. In New Inbound Rule Wizard menu

a. Select Port and click Next.

b. Select TCP as rule apply and enter 5000 for Specific local ports and click Next.
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c. Select Allow the connection and click Next.

d. Select Domain, Private, Public and click Next.

TekExpress SCPI commands

TekExpress® DisplayPort Automated Solution Application Help 175



e. Enter Name, Description (optional), and click Finish.

4. Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.
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TekVISA configuration
1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Select Socket from the drop-down list, enter the IP address of

the TekExpress device in Hostname and type Port as 5000. Click  to configure the IP address with Port.
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Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
TekExpress application system.

3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.
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4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.

TEKEXP:*IDN?
This command queries the active TekExpress application name running on the oscilloscope. 
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Syntax
TEKEXP:*IDN?\n

Inputs
NA

Outputs
Returns active TekExpress application name running on the oscilloscope.

TEKEXP:*OPC?
This command queries the execution status of the last executed command. 

Syntax
TEKEXP:*OPC?\n

Inputs
NA

Outputs
0 - last command execution is not complete

1 - last command execution is complete

TEKEXP:ACQUIRE_MODE
This command sets the acquire mode as live or pre-recorded.

Syntax
TEKEXP:ACQUIRE_MODE {LIVE | PRE-RECORDED}\n

Inputs
{LIVE | PRE-RECORDED}

Outputs
NA

TEKEXP:ACQUIRE_MODE?
This command queries the acquire mode type.

Syntax
TEKEXP:ACQUIRE_MODE?\n
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Inputs
NA

Outputs
{LIVE | PRE-RECORDED}

TEKEXP:EXPORT
This command returns all the bytes of data to the specified file. 

Syntax Outputs
TEKEXP:EXPORT REPORT\n Returns the report file in bytes
TEKEXP:EXPORT WFM,"<FileName>"\n Returns the specified waveform file in bytes
TEKEXP:EXPORT IMAGE,"<FileName>"\n Returns the specified image file in bytes

Inputs
FileName - Specifies the file name

TEKEXP:INFO?
This command queries the information about the file(s).

Syntax Outputs
TEKEXP:INFO?
REPORT\n

<ReportFileSize>,"<ReportFileName.mht>"

TEKEXP:INFO? WFM\n <WfmFile1Size>,"<WfmFileName1.wfm>";<WfmFile2Size>,"<WfmFileName2.wfm>";...
TEKEXP:INFO? IMAGE\n <Image1FileSize>,"<Image1FileName>";<Image2FileSize>,"<Image2FileName>" ;...

TEKEXP:INSTRUMENT
This command sets the value for the selected instrument type. 

Syntax
TEKEXP:INSTRUMENT "<InstrumentType>",<Value>"\n

Inputs
InstrumentType
Value

Tip: Check Command parameters list section for InstrumentType and Value parameters.
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Outputs
NA

TEKEXP:INSTRUMENT?
This command queries the instrument selected for the specified instrument type. 

Syntax
TEKEXP:INSTRUMENT? "<InstrumentType>"\n

Inputs
InstrumentType

Tip: Check Command parameters list section for InstrumentType parameters.

Outputs
Returns the instrument selected for the specified instrument type

TEKEXP:LASTERROR?
This command queries the last error string occurred for the current TCP session. If there are no errors since startup, or since the last call to
TEKEXP:LASTERROR?\n, this command returns an empty string.

Syntax
TEKEXP:LASTERROR?\n

Inputs
NA

Outputs
<string>

TEKEXP:LIST?
This command queries the list of available device, suite, test, version or instrument. 

Syntax Outputs
TEKEXP:LIST? DEVICE\n Returns the list of available device(s) as comma separated values.
TEKEXP:LIST? SUITE\n Returns the list of available suite(s) as comma separated values.
TEKEXP:LIST? TEST\n Returns the list of available test(s) as comma separated values.
TEKEXP:LIST? VERSION\n Returns the list of available version(s) as comma separated values.
TEKEXP:LIST?
INSTRUMENT,"<InstrumentType>"\n

Returns the list of available instruments' for the given Instrument
type as comma separated values.

TekExpress SCPI commands

182



Note: This command returns the list of items within double quotes (""). Iterate the receive procedure until the list ends with double
quotes otherwise the next query commands won’t work as expected.

Inputs
InstrumentType

Tip: Check Command parameters list section for Instrument Type parameters.

TEKEXP:MODE
This command sets the execution mode as compliance or user defined. 

Syntax
TEKEXP:MODE {COMPLIANCE | USER-DEFINED}\n

Inputs
{COMPLIANCE | USER-DEFINED}

Outputs
NA

TEKEXP:MODE?
This command queries the execution mode type. 

Syntax
TEKEXP:MODE?\n

Inputs
NA

Outputs
{COMPLIANCE | USER-DEFINED}

TEKEXP:POPUP
This command sets the response to the active popup shown in the application.

Syntax
TEKEXP:POPUP “<PopupResponse>”\n

Inputs
PopupResponse
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Outputs
NA

TEKEXP:POPUP?
This command queries the active popup information shown in the application.

Syntax
TEKEXP:POPUP?\n

Inputs
NA

Outputs
Returns the active popup information in the application.

TEKEXP:REPORT
This command generates the report for the current session. 

Syntax
TEKEXP:REPORT GENERATE\n

Inputs
GENERATE

Outputs
NA

TEKEXP:REPORT?
This command queries the queried header field value in the report.

Syntax
TEKEXP:REPORT? “<HeaderField>”\n

Inputs
HeaderField - Specifies to return the measured value for the indicated test.

Tip: Check Report for HeaderField parameters.
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Outputs
Returns the queried header field value in the report

TEKEXP:RESULT?
This command queries the result available in report summary/details table.

Syntax Outputs
TEKEXP:RESULT? "<TestName>"\n Return Pass/Fail status of the test.
TEKEXP:RESULT?
"<TestName>","<ColumnName>"\n

Returns all the row values of the specified column for the test.

TEKEXP:RESULT?
"<TestName>","<ColumnName>",<RowNumber
>\n

Returns the column value for the specified row number 2

Inputs
TestName - Specifies the name of the test for which to obtain the test result value.

ColumnName - Specifies the column name for the measurement

RowNumber - Specifies the row number of the measurement

Tip: Check Results panel for TestName, ColumnName, and RowNumber parameters.

TEKEXP:SELECT
This command selects the device, suite, version, or test. 

Syntax
TEKEXP:SELECT <string1>,<string2>,<string4>\n
TEKEXP:SELECT TEST,<string3>,<string4>\n

Inputs
<string1> = {DEVICE | SUITE | VERSION}
<string2> = {DeviceName | SuiteName | VersionName}
<string3> = {“<TestName>"| ALL| REQUIRED }
<string4> = {TRUE | FALSE}

Tip: Check Command parameters list section for DeviceName, SuiteName, VersionName, and TestName parameters.

2 Row number starts from zero.
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Outputs
NA

TEKEXP:SELECT?
This command queries the name of the selected device, suite, version, or test. 

Syntax
TEKEXP:SELECT? {DEVICE | SUITE | TEST | VERSION}\n

Inputs
{DEVICE | SUITE | TEST | VERSION}

Outputs
Returns the name of the selected device, suite, version, or test.

TEKEXP:SETUP
This command sets the value of the current setup.

Syntax Outputs

TEKEXP:SETUP DEFAULT\n Restore to default Setup

TEKEXP:SETUP OPEN,"<SessionName>"\n Open the session

TEKEXP:SETUP SAVE\n Saves the already existing modified session

TEKEXP:SETUP SAVE,"<SessionName>"\n Save the session

Inputs
SessionName - The name of the session

TEKEXP:STATE
This command sets the execution state of the application.

Syntax
TEKEXP:STATE {RUN | STOP | PAUSE | RESUME}\n

Inputs
{RUN | STOP | PAUSE | RESUME}
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Outputs
NA

TEKEXP:STATE?
This command queries the current setup state. 

Syntax Outputs
TEKEXP:STATE? RUNNING | PAUSED | WAIT | ERROR | READY
TEKEXP:STATE? SETUP SAVED | NOT_SAVED

TEKEXP:VALUE
This command sets the value of parameters of type General, Acquire, Analyze, or DUTID. 

Syntax
TEKEXP:VALUE GENERAL,"<ParameterName>",“<Value>”\n
TEKEXP:VALUE ACQUIRE,“<TestName>","<AcquireType>", "<ParameterName>",“<Value>”\n
TEKEXP:VALUE ANALYZE,“<TestName>","<ParameterName>".“<Value>”\n
TEKEXP:VALUE DUTID,“<Value>”\n
TEKEXP:VALUE VERBOSE,{TRUE | FALSE}\n
TEKEXP:VALUE WFMFILE,<Test_Name>,<Aquire_Type>,<FilesName1$FileName2>\n

Inputs
ParameterName - Specifies the parameter name

TestName - Specifies the test name

AcquireType - Specifies the acquire type

Value - Specifes the value to set

FilesName1$FileName2 - Specifies the waveform file name

TRUE - Pop-ups are enabled

FALSE - Pop-ups are disabled

Tip: Check Command parameters list section for ParameterName, AcquireType, and Value parameters.

Outputs
NA
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TEKEXP:VALUE?
This command queries the value of the parameter for type General, Acquire, Analyze, or DUTID.

Syntax Outputs
TEKEXP:VALUE? GENERAL,"<ParameterName>"\n Returns the value of Parameter for type GENERAL
TEKEXP:VALUE? ACQUIRE,“<TestName>",
"<AcquireType>","<ParameterName>"\n

Returns the value of Parameter for type ACQUIRE

TEKEXP:VALUE? ANALYZE,
“<TestName>","<ParameterName>"\n

Returns the value of Parameter for type ANALYZE

TEKEXP:VALUE? DUTID\n Returns the DUTID value
TEKEXP:VALUE?
WFMFILE,<Test_Name>,<Aquire_Type>\n

Returns the waveform file name

TEKEXP:VALUE? VERBOSE Returns the verbose mode type

Inputs
ParameterName - Specifies the parameter name

TestName - Specifies the test name

AcquireType - Specifies the acquire type

TRUE - Pop-ups are enabled

FALSE - Pop-ups are disabled

Tip: Check Command parameters list section for ParameterName and AcquireType parameters.

Outputs
Returns the value of Parameter for type GENERAL | ACQUIRE | ANALYZE | DUTID.

Command parameters list
TekExpress DisplayPort Tx command parameters
Parameters name and value for DUT, Test selection, Acquisition, Configuration and Preferences tabs:

Specifies the parameters name and value for DUT, Test selection, Acquisition, Configuration and Preferences tabs.

Table 19: Parameters name and value for DUT tab

Parameters Description
DUT ID Specifies the value parameters

For DUTID, valid value is: Comment

Table continued…
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Parameters Description
Acquiremode Specifies the acquire mode parameters

• Acquire live waveforms
• Use pre-recorded waveform files

View Sets the view mode

• Compliance
• Advanced

RBR • Included
• Excluded

HBR • Included
• Excluded

HBR2 • Included
• Excluded

HBR3 • Included
• Excluded

PreEmphasis-0dB • Included
• Excluded

PreEmphasis-3.5dB • Included
• Excluded

PreEmphasis-6dB • Included
• Excluded

PreEmphasis-9.5dB • Included
• Excluded

SSC • SSC Enable
• SSC Disable
• Both

Voltage swing-400mV • Included
• Excluded

Voltage swing-600mV • Included
• Excluded

Voltage swing-800mV • Included
• Excluded

Table continued…
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Parameters Description
Voltage swing-1200mV • Included

• Excluded

Link Widths • 1 Lane
• 2 Lanes
• 4 Lanes

DUT control • DP AUX
• DP AUX-Nvidia
• Manual
• DPR-100
• TenLira DPR-100

Controller • GRL
• Dongle

Signal Validation • Skip validation
• Skip test if validation fails
• Prompt if validation fails
• Validate pattern but use pattern as is

Signal Validation: Data Rate • Included
• Excluded

Signal Validation: Pattern type • Included
• Excluded

Signal Validation: SSC • Included
• Excluded
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Table 20: Parameter name and value for Test Selection tab

Parameters Description

TestName Specifies the test measurement name.

Valid values for DisplayPort Tx are:

• Eye diagram testing
• Non Pre-Emphasis Level Verification Testing
• Pre-Emphasis Level Verification Testing
• HBR2/HBR3 Level and Equalization Verification Testing
• Test 3.4_Inter-Pair Skew Testing
• Intra-pair Skew Test
• AC Common Mode Noise Measurements
• Non ISI Jitter Measurements
• Tota Jitter (TJ) Measurements
• RandomJitter (RJ) Measurements
• Main Link Frequency Compliance
• Spread Spectrum Modulation Frequency
• Spread Spectrum Modulation Deviation
• dF/dt Spread Spectrum Deviation HF Variation

Valid valued for DisplayPort++ are:

• Dual-mode TMDS Clock
• Dual-mode Eye diagram testing

Valid valued for AUX Channel Test are:

• AUX Manchester Channel EYE Test
• AUX Channel EYE Sensitivity Test
• Inrush Test
• AUX Slew Rate

Table 21: Parameter name and value for Acquisitions tab

Parameters Description

Probe1, Probe 2 Specifies the probe source channel for each listed signal.

Valid values are:

• CH1
• CH2
• CH3
• CH4

Show Acquire Parameters TRUE or FALSE

Table continued…
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Parameters Description

Embed/De-embed Filter • Included
• Excluded

DC Voltage • Auto
• Internal

DeEmbed Filter Path Complete Path of filter file has to be updated

Table 22: Parameter name and value for Preferences tab

Parameters Description
Number of Runs 1 to 250
Timer Warning Info Message
Popup

TRUE

FALSE

Timer Warning Info Message
Popup Duration

1 to 60

Timer Error Message Popup TRUE

FALSE

Timer Error Message Popup 1 to 60

Parameter name and value for General, Acquire and Analyze:

Specifies the parameter name and value for General, Acquire and Analyze. The configuration parameters available are not same for
measurements.

Table 23: Parameter name and value for General

Parameter name Value
Report Update Mode • New

• Append
• Replace
• ReplaceAny

Report name X:\DisplayPort\Reports\DUT001.mht

Save As Type • Web Archive (*.mht;*.mhtml)
• PDF (*.pdf)
• CSV (*.csv)

Auto increment report name if
duplicate

• Included
• Excluded

Table continued…
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Parameter name Value
Create report automatically at the
end of the run

• Included
• Excluded

Include pass/fail results
Summary

• Included
• Excluded

Include detailed results • Included
• Excluded

Include plot images • Included
• Excluded

Include setup configuration • Included
• Excluded

Include user comments • Included
• Excluded

Include informative results • Included
• Excluded

Report Group mode • Test Name
• Test Result
• Lane Name
• Data Rate
• Images

View report after generating • Included
• Excluded

Save As type • Web Archive (*.mht;*.mhtml)
• PDF (*.pdf)
• CSV (*.csv;)

DSP Filter • Included
• Excluded

DSP Filter:RBR Bandwidth
(GHz)

4 to Scope Maximum BW limit

DSP Filter:HBR Bandwidth
(GHz)

8 to scope Maximum BW

DSP Filter:HBR2 Bandwidth
(GHz)

12.5 to scope Maximum BW

DSP Filter:HBR3 Bandwidth
(GHz)

16 to scope Maximum BW

Table continued…
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Parameter name Value
Report Create Method Type • Compliance

• All Results

Table 24: Parameter name and value for Acquire

Test name Acquire type Parameter name Value

All Tests under DisplayPort Tx node

• Eye diagram testing
• Non Pre-Emphasis Level Verification

Testing
• Inter-Pair Skew Testing
• Intra-pair Skew Test
• AC Common Mode Noise

Measurements
• Non ISI Jitter Measurements
• Tota Jitter (TJ) Measurements
• RandomJitter (RJ) Measurements
• Main Link Frequency Compliance
• Spread Spectrum Modulation Frequency
• Spread Spectrum Modulation Deviation
• dF/dt Spread Spectrum Deviation HF

Variation

PRBS7

D10.2

RBR:Sample Rate(GS/s) 10 to 100
HBR:Sample Rate(GS/s) 10 to 100
HBR2:Sample Rate(GS/s) 10 to 100
HBR2:Sample Rate(GS/s) 10 to 100
HBR3:Sample Rate(GS/s) 10 to 100
RBR:Record Length(M) 10 to 50
HBR:Record Length(M) 10 to 50
HBR2:Record Length(M) 10 to 50
HBR3:Record Length(M) 10 to 50

• Pre-Emphasis Level Verification Testing
• HBR2/HBR3 Level and Equalization

Verification Testing

PRBS7

D10.2

RBR:Record Length(M) 5 to 50
HBR:Record Length(M)
HBR2:Record Length(M)
HBR3:Record Length(M)

Dual-mode TMDS Clock

Dual-mode Eye diagram testing

TMDS Clock

TMDS EyeDiagram

Record Length (M) 5

10

20

Sample rate (GS/s) 10

25

50

Edge trigger slope Positive

Negative

Table continued…
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Test name Acquire type Parameter name Value
AUX Manchester Channel EYE Test AUX EyeDiagram Record Length (M) 2

4

5

Sample rate (GS/s) 6.25

12.5

50

Edge trigger slope Positive

Negative

Scale trigger settings Automatic

Normal

Scale 2
AUX Sensitivity AUX sensitivity Scale trigger settings Automatic

Normal

Record Length (M) 2

4

5

Sample rate (GS/s) 6.25

12.5

50

Edge trigger slope Positive

Negative

Scale 2 (min20, max1000)
Trigger level (mV) 50 (min20, max1000)

Inrush Test Inrush Record Length (M) 2.5

5

Sample rate (GS/s) 12.5

25

50

Table continued…
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Test name Acquire type Parameter name Value
AUX slew rate AUX slew rate Scale Trigger Settings Automatic

Normal

Record Length (M) 2

4

5

Sample rate (GS/s) 10

25

50

Edge trigger slope Positive

Negative

Scale (mV/div) 2 (min20, max1000)
Trigger level (mV) 50 (min20, max1000)
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Table 25: Parameter name and value for Analyze

Test name Acquire type Parameter name Value
Eye diagram
testing

PRBS7 Clock recovery method PLL-Custom BW

Constant Clock-Mean

PLL Model Type ONE

TWO

RBR Damping (m) 500 to 2000

RBR Loop bandwidth (MHz) 0.1 to 10

HBR Damping (m) 500 to 2000

HBR Loop bandwidth (MHz) 0.1 to 10
HBR2 Damping (m) 500 to 2000
HBR2 Loop bandwidth (MHz) 0.1 to 10
HBR3 Damping (m) 500 to 2000
HBR3 Loop bandwidth (MHz) 0.1 to 10
Ref Levels Autoset Basetop Method AUTO

MINMAX

FULLHISTOGRAM

EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

SDLA Config CTLE

CTLE, DFE
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Test name Acquire type Parameter name Value

HBR3:CTLE Zero Cable 0 dB

-1 dB

-2 dB

-3 dB

-4 dB

-5 dB

-6 dB

-7 dB

-8 dB

-9 dB

All

HBR3:CTLE Worst Case Cable 0 dB

-1 dB

-2 dB

-3 dB

-4 dB

-5 dB

-6 dB

-7 dB

-8 dB

-9 dB

All

Inter-Pair Skew
Test

PRBS7 Ref Levels Autoset Basetop Method • AUTO
• MINMAX
• FULLHISTOGRAM
• EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

Table continued…
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Test name Acquire type Parameter name Value
Intra-Pair Skew
Test

PRBS7 Ref Levels Autoset Basetop Method • AUTO
• MINMAX
• FULLHISTOGRAM
• EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

Non ISI Jitter
Measurements

PRBS7 Clock recovery method PLL-Custom BW

Constant Clock-Mean

PLL Model Type ONE

TWO

RBR Damping (m) 500 to 2000
RBR Loop bandwidth (MHz) 0.1 to 10
HBR Damping (m) 500 to 2000
HBR Loop bandwidth (MHz) 0.1 to 10
HBR2 Damping (m) 500 to 2000
HBR2 Loop bandwidth (MHz) 0.1 to 10
HBR3 Damping (m) 500 to 2000
HBR3 Loop bandwidth (MHz) 0.1 to 10
Ref Levels Autoset Basetop Method • AUTO

• MINMAX
• FULLHISTOGRAM
• EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

Table continued…
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Test name Acquire type Parameter name Value
Total Jitter (TJ)
Measurements

PRBS7 Clock recovery method PLL-Custom BW

Constant Clock-Mean

PLL Model Type ONE

TWO

RBR Damping (m) 500 to 2000
RBR Loop bandwidth (MHz) 0.1 to 10
HBR Damping (m) 500 to 2000
HBR Loop bandwidth (MHz) 0.1 to 10
HBR2 Damping (m) 500 to 2000
HBR2 Loop bandwidth (MHz) 0.1 to 10
HBR3 Damping (m) 500 to 2000
HBR3 Loop bandwidth (MHz) 0.1 to 10
Ref Levels Autoset Basetop Method • AUTO

• MINMAX
• FULLHISTOGRAM
• EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

Table continued…
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Test name Acquire type Parameter name Value
Random Jitter
(RJ)
Measurements

PRBS7 Clock recovery method PLL-Custom BW

Constant Clock-Mean

PLL Model Type ONE

TWO

RBR Damping (m) 500 to 2000
RBR Loop bandwidth (MHz) 0.1 to 10
HBR Damping (m) 500 to 2000
HBR Loop bandwidth (MHz) 0.1 to 10
HBR2 Damping (m) 500 to 2000
HBR2 Loop bandwidth (MHz) 0.1 to 10
HBR3 Damping (m) 500 to 2000
HBR3 Loop bandwidth (MHz) 0.1 to 10
Ref Levels Autoset Basetop Method • AUTO

• MINMAX
• FULLHISTOGRAM
• EYEHISTOGRAM

Ref levels • Absolute
• Percentage

Mid level -10 to 10 (Ref level=Absolute)

20 to 80 (Ref level=Percentage)

Hysteresis -2 to 2 (Ref level=Absolute)

2 to 20 (Ref level=Percentage)

Dual-mode TMDS
Clock

TMDS Clock Signal Type • CLOCK
• DATA
• AUTO

Clock Edge • RISE
• FALL
• BOTH

Clock recovery method PLL-Custom BW
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Examples
Example Description
TEKEXP:*IDN? It returns the active TekExpress application name running on the

scope.
TEKEXP:*OPC? It returns the last command execution status.
TEKEXP:ACQUIRE_MODE PRE-RECORDED It sets the acquire mode as pre-recorded.
TEKEXP:ACQUIRE_MODE? It returns LIVE when acquire mode is set to live.
TEKEXP:EXPORT REPORT It returns the report file in bytes. This can be written into another file

for further analysis.
TEKEXP:INFO? REPORT It returns “100,”ReportFileName.mht”", when 100 is the file size in

bytes for the filename ReportFileName.
TEKEXP:INFO? WFM It returns “100,“WfmFileName1.wfm”";“200,“WfmFileName2.wfm”"

when 100 is the filesize in bytes for the filename
WfmFileName1.wfm and 200 is the filesize in bytes for the filename
WfmFileName2.wfm.

TEKEXP:INSTRUMENT "Real Time
Scope",DPO72504D ( GPIB8::1::INSTR )

It sets the instrument value as DPO72504D ( GPIB8::1::INSTR ) for
the selected instrument type Real Time Scope.

TEKEXP:INSTRUMENT? “Real Time Scope” It returns "DPO72504D ( GPIB8::1::INSTR ), when DPO72504D
( GPIB8::1::INSTR )" is the selected instrument for the instrument
type Real Time Scope.

TEKEXP:LASTERROR? It returns ERROR: INSTRUMENT_NOT_FOUND, when no
instrument is found.

TEKEXP:LIST? DEVICE It returns "Transmitter" when Transmitter is the available device.
TEKEXP:LIST? INSTRUMENT,"Real Time Scope" It returns "DPO72504D ( GPIB8::1::INSTR ),MSO72504

( TCPIP::134.64.248.91::INSTR )" when DPO72504D
( GPIB8::1::INSTR ), MSO72504 ( TCPIP::134.64.248.91::INSTR )
are the list of available instruments.

TEKEXP:MODE COMPLIANCE It sets the execution mode as compliance.
TEKEXP:MODE? It returns COMPLIANCE when the execution mode is compliance.
TEKEXP:POPUP “OK” It sets OK as the response to active popup in the application.
TEKEXP:POPUP? It returns "OK", when OK is the active popup information shown in

the application.
TEKEXP:REPORT GENERATE It generates report for the current session.
TEKEXP:REPORT? “Scope Model” It returns "DPO73304SX" when DPO73304SX is the scope model.
TEKEXP:REPORT? “DUT ID” It returns "DUT001" when DNI_DUT001 is the DUT ID.
TEKEXP:RESULT? "Eye diagram testing" It returns Pass, then the test result is Pass.
TEKEXP:RESULT? "Eye diagram testing",
"Margin"

It returns list of values then that is ‘Margin’ column data.

TEKEXP:RESULT? "Eye diagram testing",
"Units",0

It returns the unit of the first row of result.

TEKEXP:SELECT DEVICE,"DisplayPort" It selects device "DisplayPort".
Table continued…
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Example Description
TEKEXP:SELECT TEST,"Eye diagram testing",
TRUE

It selects "Eye diagram testing" measurement.

TEKEXP:SETUP DEFAULT It restores the application to default setup.
TEKEXP:STATE STOP It stops the test execution.
TEKEXP:STATE? It returns as READY when the application is ready to run next

measurement.
TEKEXP:STATE? SETUP It returns as NOT_SAVED when the current setup is not saved.
TEKEXP:VALUE GENERAL,"RBR","Included" It selects RBR data rate.
TEKEXP:VALUE? GENERAL,"RBR” It returns 'Included', then RBR is selected in DUT panel.

Examples script files are present in installation directory. Refer the following path for accessing the examples, C:\Program
Files\Tektronix\TekExpress\TekExpress DisplayPortTx\Examples.

Switch Matrix commands
This section describes the switch matrix commands. It is recommended to execute the switch matrix commands through GPIB interface.

SWITCH:*IDN
This command queries the switch matrix version information.

Syntax
SWITCH:*IDN?\n

Inputs
NA

Outputs
Returns the switch martrix version information.

Example
SWITCH:*IDN?\n returns "Tektronix,Switch Matrix,v1.0.0.0", where v1.0.0.0 is the Switch Matrix version.

SWITCH:*OPC
This command queries the previously executed commands execution status.

Syntax
SWITCH:*OPC?\n

Inputs
NA
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Outputs
Returns 0 if the previously executed command execution is in progress.

Returns 1 if the previously executed command execution is done.

Example
SWITCH:*OPC?\n returns 1, when the previously executed command execution is done.

SWITCH:CONFIG
This command sets or queries the config file.

Syntax
SWITCH:CONFIG {"<ConfigName>" | "<UserConfigFilePath>"}\n
SWITCH:CONFIG?\n

Inputs
<ConfigName> specifies the config file.

<UserConfigFilePath> specifies the config file from the given path.

Outputs
Returns the loaded config file name with path.

Examples
SWITCH:CONFIG "Keithley S46T"\n sets the config file of Keithley.

SWITCH:CONFIG "E:\myconfig.xml"\n sets the config file from the given path.

SWITCH:CONFIG?\n returns "E:\myconfig.xml".

SWITCH:DE-EMBED:ALL:FILTER_FILE
This command sets the filter file for all connections.

Syntax
SWITCH:DE-EMBED:ALL:FILTER_FILE
"<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs
<SwitchFilterFilePath> specifies the switch filter file path.

<FixtureFilterFilePath> specifies the fixture filter file path.

Outputs
NA
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Example
SWITCH:DE-EMBED:ALL:FILTER_FILE
"C:\FilterFiles\SWTCH1.flt","C:\FilterFiles\CABLE_1.flt"\n sets the switch filter file for all connections
and the fixture filter file for all cables connected.

SWITCH:DE-EMBED:CONN:FILTER_FILE
This command sets the filter file for the switch, fixture, and cable for the specified connection.

Syntax
SWITCH:DE-EMBED:CONN:FILTER_FILE
"<RelayName>","<InputName>","<SwitchFilterFilePath>","<FixtureFilterFilePath>","<Ca
bleFilterFilePath>"\n

Inputs
<RelayName> specifies the relay name.

<InputName> specifies the input name.

<SwitchFilterFilePath> specifies the switch filter file path.

<FixtureFilterFilePath> specifies the fixture filter file path.

<CableFilterFilePath> specifies the cable filter file path.

Example
SWITCH:DE-EMBED:CONN:FILTER_FILE "Relay
A","1","C:\FilterFiles\RA_1.flt","C:\FilterFiles\Fxtre_1.flt","C:\FilterFiles\cbl_1
.flt"\n sets filter files to Relay A's input 1 and to the connected cable.

SWITCH:DE-EMBED:FILTER_FILE
This command queries the filter file based on the mode selected in the application.

Syntax
SWITCH:DE-EMBED:FILTER_FILE?\n

Inputs
NA

Outputs
Returns the filter file in any of the the below specified format, based on the mode selected.

None

ALL;"<SwitchFilterFilePath>","<FixtureFilterFilePath>";
Table continued…
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RELAY_TYPE;"<RelayType1>","<SwitchFilterFilePath1>","<FixtureFilterFilePath1>";"<Re
layType2>","<SwitchFilterFilePath2>","<FixtureFilterFilePath2>";

RELAY;"<RelayName1>","<SwitchFilterFilePath1>","<FixtureFilterFilePath1>";"<RelayNa
me2>","<SwitchFilterFilePath2>","<FixtureFilterFilePath2>";

CONN;"<RelayName1>","<InputName1>,"<SwitchFilterFilePath1>","<FixtureFilterFilePath
1>","<CableFilterFIlePath1>;"<RelayName1>","<InputName2>,"<SwitchFilterFilePath2>",
"<FixtureFilterFilePath2>","<CableFilterFIlePath2>;

Example
SWITCH:DE-EMBED:FILTER_FILE?\n returns ALL;"C:\FilterFiles\SWTCH1.flt" ,"C:\FilterFiles\Fxtre_1.flt".

SWITCH:DE-EMBED:MODE
This command sets or queries the De-Embed mode.

Syntax
SWITCH:DE-EMBED:MODE {NONE | ALL | RELAY_TYPE | RELAY | CONN}\n
SWITCH:DE-EMBED:MODE?\n

Inputs
{NONE | ALL | RELAY_TYPE | RELAY | CONN}

Outputs
Returns the De-Embed mode.

Examples
SWITCH:DE-EMBED:MODE ALL\n sets the De-Embed mode as ALL.

SWITCH:DE-EMBED:MODE?\n returns ALL.

SWITCH:DE-EMBED:RELAY:FILTER_FILE
This command sets the filter file and fixture file for the specified relay.

Syntax
SWITCH:DE-EMBED:RELAY:FILTER_FILE
"<RelaName>","<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs
<RelaName> specifies the relay name.

<SwitchFilterFilePath> specifies the switch filter file path.

<FixtureFilterFilePath> specifies the fixture filter file path.
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Outputs
SWITCH:DE-EMBED:RELAY:FILTER_FILE "Relay
A","C:\FilterFiles\RA.flt","C:\FilterFiles\Fxtre_1.flt"\n sets filter files for all connections in Relay
A.

SWITCH:DE-EMBED:RELAY_TYPE:FILTER_FILE
This command sets the filter file for specified relay type.

Syntax
SWITCH:DE-EMBED:RELAY_TYPE:FILTER_FILE
"<RelayType>","<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs
<RelayType> specifies the relay type.

<SwitchFilterFilePath> specifies the switch filter file path.

<FixtureFilterFilePath> specifies the fixture filter file path.

Example
SWITCH:DE-EMBED:RELAY_TYPE:FILTER_FILE
"SP2T","C:\FilterFiles\SP2T.flt","C:\FilterFiles\Fxtre_1.flt"\n sets filter file for SP2T relay type.

SWITCH:LASTERROR
This command queries the error occurred while executing last command.

Syntax
SWITCH:LASTERROR?\n

Inputs
NA

Outputs
Returns the error occurred while executing last command.

Error message Description

NO_ERROR No error occurred executing last command.

INVALID_COMMAND The last command sent is either invalid or syntax is not correct.

"No config file loaded." The last command to load the config file is failed.

"Invalid configuration." The last command has invalid configuration.

Table continued…
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Error message Description

"Invalid linkwidth." The last command has invalid linkwidth.

"Invalid de-embed mode." The last command has invalid de-embed mode.

"Invalid signal polarity." The last command has invalid signal polarity.

"Invalid relay name." The last command has invalid relay name.

"Invalid relay type." The last command has invalid relay type.

"Invalid signal name." The last command has invalid signal name.

"Invalid common value." The last command has invalid value for common.

"Invalid input ID." The last command has invalid input ID.

Example
SWITCH:LASTERROR?\n returns the last error occurred.

SWITCH:LINKWIDTH
This command sets or queries the link width.

Syntax
SWITCH:LINKWIDTH {X2 | X4 | X8 | X16}\n
SWITCH:LINKWIDTH?\n

Inputs
{X2 | X4 | X8 | X16}

Outputs
Returns the link width value.

Examples
SWITCH:LINKWIDTH X8\n sets the linkWidth to 8.

SWITCH:LINKWIDTH?\n returns 8.

SWITCH:RELAY:CASCADE
This command sets or queries the cascade of the relay.

Syntax
SWITCH:RELAY:CASCADE "<FromRelayName>","<ToRelayName>","<InputName>"\n
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SWITCH:RELAY:CASCADE? "<RelayName>"\n

Inputs
<FromRelayName> specifies the relay name from which to cascade.

<ToRelayName> specifies the relay name to cascade.

<InputName> specifies the input name of the relay to cascade.

<RelayName> specifies the relay name.

Outputs
Returns the cascading info of the relay if cascaded else returns NOT_CASCADED.

Example
SWITCH:RELAY:CASCADE "Relay A","Relay B","2"\n sets Relay A's output cascade to Relay B's input 2.

SWITCH:RELAY:CASCADE? "Relay A"\n returns "Relay B","2".

SWITCH:RELAY:CASCADE? "Relay B"\n returns NOT_CASCADED.

SWITCH:RELAY:CASCADED
This command sets or queries cascaded state of the relay.

Syntax
SWITCH:RELAY:CASCADED "<RelayName>",{TRUE | FALSE}\n
SWITCH:RELAY:CASCADED? "<RelayName>"\n

Inputs
<RelayName> specifies the relay name.

TRUE or FALSE to cascade the relay or not.

Outputs
Returns whether the relay is cascaded or not.

Examples
SWITCH:RELAY:CASCADED "Relay A",TRUE\n sets the cascaded state of Relay A to TRUE.

SWITCH:RELAY:CASCADED? "Relay A"\n returns TRUE.

SWITCH:RELAY:COMMON
This command sets or queries the relays common connection connected to scope channels.

Syntax
SWITCH:RELAY:COMMON "<RelayName>",{CH1 | CH2 | CH3 | CH4}\n
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SWITCH:RELAY:COMMON? "<RelayName>"\n

Inputs
<RelayName> specifies the relay name.

{CH1 | CH2 | CH3 | CH4} specifies the channel number.

Outputs
Returns the channel connected to the common connection of relay.

Example
SWITCH:RELAY:COMMON "Relay A",CH1\n sets the common connection of Relay A to CH1.

SWITCH:RELAY:COMMON? "Relay A"\n returns CH1.

SWITCH:RELAY:POLARITY
This command sets or queries the signal polarity of the specified relay.

Syntax
SWITCH:RELAY:POLARITY "<RelayName>",{POS | NEG | DIFF}\n
SWITCH:RELAY:POLARITY? "<RelayName>"\n

Inputs
<RelayName> specifies the relay name.

{POS | NEG | DIFF} specifies the signal polarity as Positive, Negative or Differential respectively.

Outputs
Returns the signal polarity of the relay.

Examples
SWITCH:RELAY:POLARITY "Relay A",POS\n sets the Relay A's signal polarity to POS.

SWITCH:RELAY:POLARITY? "Relay A"\n returns POS.

SWITCH:RELAY:SIGNAL
This command sets or queries the signal name connected to input port.

Syntax
SWITCH:RELAY:SIGNAL "<RelayName>","<InputName>","<SignalName>"\n
SWITCH:RELAY:SIGNAL? "<RelayName>","<InputName>"\n

Inputs
<RelayName> specifies the relay name.
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<InputName> specifies the input name of the relay.

<SignalName> specifies the signal name to connect to the relays input.

Outputs
Returns the signal name connected to the input port.

Example
SWITCH:RELAY:SIGNAL "Relay A","1","Lane0+"\n sets the signal name Lane0+ to Relay A's input 1.

SWITCH:RELAY:SIGNAL? "Relay A","1"\n returns "Lane0+".
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Reference

Deskew channels
If skew is present between positive and negative channels, then the channels need to be deskewed before being used for waveform
measurements. TekExpress DisplayPort solution provides support for channel deskew using the following method: 

1. Determine what the skew is for each channel.
2. From the TekScope menu, click Vertical and select Deskew.
3. In the Deskew/Attenuation window, click the channel (1 – 4) button for the first channel to be deskewed.
4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or –ve.
5. Click the channel button for the next channel and repeat step 4, above.
6. After entering the skew for all the channels that require it, from the Options menu in TekExpress DisplayPort, select Deskew.
7. In the Deskew dialog box, select the desired level:

• Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is less than
100 mV/division.

• 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is greater than
100 mV/division.

8. Click Read Deskew/Attn.
9. When finished, click Close.

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or cables of different lengths. The
instrument applies the delay values after each completed acquisition. The deskew values are saved as part of the instrument setup. The
deskew values for the selected channel are retained until you change the probe, you restore a saved setup, or you recall the factory setup.

See Also
Pre-Run checklist

Appendix-A
Following are the compliance parameters for all DisplayPort measurements for CTS 1.2.

Table 26: Compliance parameters list for all DisplayPort measurements for CTS 1.2

Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.1 Eye diagram testing RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR2 All All SSC Enabled/SSC

Disabled/Both
Table continued…
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Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.2 Non pre-emphasis level

verification testing
RBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR2 Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
3.3 Pre-emphasis level

verification testing
RBR All All SSC Enabled/SSC

Disabled/Both
HBR All All SSC Enabled/SSC

Disabled/Both
HBR2 All All SSC Enabled/SSC

Disabled/Both
3.4 Inter pair skew test RBR Level 0 (0 dB) Level 2 (800 mV SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) Level 2 (800 mV SSC Enabled/SSC

Disabled/Both
HBR2 Level 0 (0 dB) Level 2 (800 mV SSC Enabled/SSC

Disabled/Both
3.5 Intra pair skew test RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
3.10 AC common mode noise

measurements
RBR All All SSC Enabled/SSC

Disabled/Both
HBR All All SSC Enabled/SSC

Disabled/Both
HBR2 All All SSC Enabled/SSC

Disabled/Both
3.11 Non ISI jitter

measurements
RBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
3.12.1 Total Jitter (TJ)

measurements
RBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR2 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1

3.12.2 Random jitter
measurements

HBR2 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1

Table continued…
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Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.14 Main link frequency

compliance
RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
3.15 Spread spectrum

modulation frequency
RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled

3.16 Spread spectrum
modulation deviation

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled

3.17 dF/dt spread spectrum
deviation HF variation

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled

Appendix-B
Following are the compliance parameters for all DisplayPort measurements for CTS 1.4.

Table 27: Compliance parameters list for all DisplayPort measurements for CTS 1.4

Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.1 Eye diagram testing RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC

Disabled/Both
HBR2 All All SSC Enabled/SSC

Disabled/Both
HBR3 All All SSC Enabled/SSC

Disabled/Both
3.2 Non pre-emphasis level

verification testing
RBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
3.3 HBR/RBR pre-emphasis

level verification testing
RBR All All SSC Enabled/SSC

Disabled/Both
HBR All All SSC Enabled/SSC

Disabled/Both
Table continued…
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Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.4 HBR2/HBR3 pre-

emphasis level and
equalization verification
test

HBR2 All All SSC Enabled/SSC
Disabled/Both

HBR3 All All SSC Enabled/SSC
Disabled/Both

3.5 HBR2/HBR3 peak to peak
voltage

HBR2 All All SSC Enabled/SSC
Disabled/Both

HBR3 All All SSC Enabled/SSC
Disabled/Both

3.6 Inter pair skew test RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

3.7 Intra pair skew test RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

3.8 AC common mode noise
measurements

RBR All All SSC Enabled/SSC
Disabled/Both

HBR All All SSC Enabled/SSC
Disabled/Both

HBR2 All All SSC Enabled/SSC
Disabled/Both

HBR3 All All SSC Enabled/SSC
Disabled/Both

3.9 Non ISI jitter
measurements

RBR Level 0 (0 dB) All SSC Enabled/SSC
Disabled/Both

HBR Level 0 (0 dB) All SSC Enabled/SSC
Disabled/Both

HBR2 Level 0 (0 dB) All SSC Enabled/SSC
Disabled/Both

HBR3 Level 0 (0 dB) All SSC Enabled/SSC
Disabled/Both

Table continued…
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Test ID Test name Data rate Pre-emphasis level Voltage swing SSC
3.11.1 Total Jitter (TJ)

measurements
RBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR Level 0 (0 dB) All SSC Enabled/SSC

Disabled/Both
HBR2 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1
HBR3 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1

3.11 Random jtter
measurements

HBR2 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1
HBR3 Same as Test 3.1 Same as Test 3.1 Same as Test 3.1

3.12 Main link frequency
compliance

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled/SSC
Disabled/Both

3.13 Spread spectrum
modulation frequency

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled

3.14 Spread spectrum
modulation deviation

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled

3.15 dF/dt spread spectrum
deviation HF variation

RBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR2 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
HBR3 Level 0 (0 dB) Level 2 (800 mV) SSC Enabled
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